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Chapter 1. Introduction

This chapter provides an overview of QMF for Windows and explains some
of the basic tasks for getting started with QMF for Windows.

Database servers

Queries, forms, procedures, and tables are run and saved at a database server.

DB2 family of databases
QMF for Windows can connect to a wide range of DB2 databases.
v DB2 UDB for OS⁄390, DB2 for OS⁄390, and DB2 for MVS
v DB2 Server for VSE & VM and SQL⁄DS
v DB2 Universal Database and DB2 Common Server
v DB2 Parallel Edition
v DataJoiner

Your QMF for Windows license determines which DB2 family products you
can install on and connect to with your copy of QMF for Windows.

User name vs. technical name
Different versions and types of DB2 refer to a database by an RDB name,
location name, or other technical name.

With QMF for Windows your administrator can assign an easily remembered
name to a database name, for example, Purchasing Database instead of
DB2P_01_PURCH.

QMF for Windows refers to a database server or a DB2 database as a "server."

Setting the server name
Before you can query a database, QMF for Windows needs to know where the
database is stored.
1. From the File menu, select New SQL Query. A new SQL query document

opens.

© Copyright IBM Corp. 1997, 2000 1



2. From the Query menu, select Set Server. The Set Server dialog box opens.

3. From the list of available servers, select the one that you want to query
and click OK. When you begin your next QMF for Windows session, QMF
for Windows automatically reconnects to the same server.

Database security

You must provide a user ID and password before you can connect to a server.

Logging on
You must specify a valid user ID and password for the database server that
you are trying to access. The database server user ID and password is not
necessarily the same as your local or network user ID and password.

If you are running Windows, you have the option of remembering server
passwords across QMF for Windows sessions. If you are currently logged on
to Windows, the Set User Information dialog box displays an additional check
box labeled Remember this password?. If you select this check box, then the
password you enter for that server is stored in the Windows password list.
Whenever you are logged on to Windows, QMF for Windows can
automatically retrieve that password so that you are not prompted. If you are
not logged on when you run QMF for Windows, or if you are logged on as a
different user, QMF for Windows prompts you for a user ID and password.

Note: If you choose to save a password, anyone who can log on to your
Windows account can access your database servers with your (server)
user ID and password.

2 QMF: Getting Started with QMF for Windows



1. From the Query menu, select Set User Information. The Set User
Information dialog box opens.

2. Enter your user ID and password in the appropriate fields.

Note: The user ID and password are case sensitive. For example, if your
user ID or password is uppercase, you must enter it in uppercase.
Some types of database servers treat user IDs and passwords as
case sensitive; others do not.

3. Check Remember this password? if you want to save your user ID and
password.

4. Click OK. QMF for Windows stores this information in preparation for
accessing the server.

Correcting passwords
If you entered an incorrect password, you can correct the error by reopening
the Set User Information dialog box.
1. From the Query menu, click Set User Information. The Set User

Information dialog box opens.
2. Type the password again and click OK. The password is corrected.

Changing passwords
You can change your password at the database server from QMF for
Windows. This feature is currently supported only by DB2 for OS⁄390 Version
5 and later.
1. From the Query menu, select Set User Information. The Set User

Information dialog box opens.
2. Click Change. The New password and Confirm new password fields

appear.
3. Type your new password in the New password and Confirm new

password fields and click OK. Your database server password is changed.
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Specifying accounting strings
The database server uses accounting strings to track system usage. Ask your
database administrator to find out if your system uses accounting strings.
1. From the Query menu, select Set User Information. The Set User

Information dialog box opens.
2. In the Accounting string field, type the accounting string you want to use

and click OK. QMF for Windows stores the information in preparation for
accessing the server.

Governing

The QMF for Windows governor is always running in the background,
monitoring the usage of database and system resources. The governor also
limits the type and size of queries you can run.

Viewing resource limits
From the View menu, select Resource Limits. The Resource Limits dialog box
opens. All information in the Resource Limits dialog box is read only. Your
system administrator sets these limits.

4 QMF: Getting Started with QMF for Windows



The types of limits and controls that can be in effect are:
v Timeouts
v Limits
v SQL Verbs
v Options
v Save Data
v Binding
v Object Tracking

Setting your own row limit
You can specify the maximum number of rows to retrieve for this query.
When this limit is reached, QMF for Windows cancels the query. The
maximum authorized row limit specified in your resource limits group takes
precedence over this parameter.

Enter 0 to specify no limit in this field.

Rows that QMF for Windows has already retrieved in excess of this limit are
retained and available for viewing.
1. From the Query menu, click Set Row Limit. The Set Row Limit dialog box

opens..

2. Enter the maximum number of rows that you want the query to return
and click OK. The row limit is applied the next time you run the query.

Customizing the toolbar

You can customize the toolbar to display only the buttons that you want to
see.

Adding buttons to the toolbar
You have the option of adding buttons to the existing QMF for Windows
toolbar. These buttons represent functions that not all users may need, but
that are available for inclusion in the toolbar.
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1. Double-click the gray area surrounding the toolbar. The Customize Toolbar
dialog box opens.

2. From the Available buttons column, select the button that you want to
add and click Add. The button is added to the toolbar.

3. When you finish adding buttons, click Close. The dialog box closes and
the new buttons are added to the toolbar.

Moving buttons on the toolbar
You have the option of rearranging the buttons on the QMF for Windows
toolbar.
1. Double-click on the gray area surrounding the toolbar. The Customize

Toolbar dialog box opens.
2. From the Available buttons column, select the button that you want to

move.
3. Use the Move Up and Move Down buttons to move the button within the

toolbar.
4. When you finish moving buttons, click Close. The dialog box closes and

the buttons appear in their new locations.

Removing buttons from the toolbar
You have the option of removing buttons from the QMF for Windows toolbar.
1. Double-click on the gray area surrounding the toolbar. The Customize

Toolbar dialog box opens.
2. From the Available buttonscolumn, select the button that you want to

remove and click Remove. The button is removed from the toolbar.
3. When you finish removing buttons, click Close. The dialog box closes and

the buttons are removed from the toolbar.
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Chapter 2. Working with SQL Queries

Structured Query Language (SQL) is the most basic interface between a user
and a database. Queries are written in SQL and processed by the database.
Users can write QMF for Windows queries in SQL, or create queries using the
"point and click" method.

SQL queries

Structured Query Language queries require knowledge of the commands and
syntax of SQL. Users unfamiliar with SQL should try creating prompted
queries.

Creating new SQL queries
Click the New SQL Query button on the toolbar.

A new query document opens.

Running SQL queries at a database server
1. Open a new query document and type in a query, or open an existing

query file, or open a query from the database.
2. Click the Run Query button on the toolbar.

The query runs and the results are displayed.

Switching between the Results view and the SQL view
You can look at either the results of a query or the SQL statement itself.

From the SQL view of a query that has been run, click the View Results
button on the toolbar.

The query results are displayed.
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-or-

From the Results view of a query, click the View SQL button.

The SQL statement is displayed.

Working with fonts

You can change the font used to display queries. The choice of fonts varies
according to what has been installed on your computer. For more information
on adding fonts, refer to your operating system’s help facility.

Note: If you save the query after selecting a new query display font, that
query is always displayed using the new font.

Selecting the query display font
1. From the SQL view, click Set Font from the Query menu. The Font dialog

box opens.
2. Select the font for displaying the text of the query and click OK. The

query reappears in the new font.

Note: Click Set As Default to use the selected font as the default font for
all new queries.

Multiple queries

You can have more than one query document open at the same time. You can
also run more than one query at a time. You can use this feature to generate
multiple reports, or to cut and paste SQL text from one query to another.

Displaying multiple queries simultaneously
1. Open at least two query documents.
2. From the Window menu, select one of the following commands:

Command Result

Cascade Displays queries in a staggered series.

Tile Horizontal Displays query windows stacked vertically.

Tile Vertical Displays query windows stacked side by side.

The query windows are arranged according to the option you select.
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Drawing queries

Use the Draw Query command to create new SQL query documents. You
specify one or more table names and the type of SQL statement that you
want, and QMF for Windows automatically creates an SQL statement that
references the names and data types of the columns in the table.

Creating new SQL queries
1. From the File menu, click Draw Query. The Draw Query dialog box

opens.

2. Select the type of query that you want to create:

Query type Result

Select Retrieve rows from one or more tables.

Update Change the information in a table.

Insert Add new rows to a table.

3. Enter the owner and name of the table to be queried.

Note: You can use patterns to select table names from a list of matching
tables.

v Use the percent character (%) to match a string of any length containing
any characters. For example, to list all tables with a name beginning
with the letter A, enter A%.
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v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

After you enter a pattern, click Add from List and select a table from the
resulting list.

4. Enter a unique identifier for the table.
5. Click Add. The table is added to the query.
6. When you have added the table or tables that you want to query, click

OK. An SQL query for the selected tables is created and displayed.

Substitution variables in SQL queries

With substitution variables, you can use the same query to retrieve different
information by supplying different values each time you run the query. To
retrieve a different set of data, you do not need to rewrite the query. Rather,
you just supply different values for the substitution variables in the query
when you run it.

A substitution variable is text that you include in a query. It must begin with
an ampersand character (&), and can contain up to 18 characters, which can
be alphabetic, numeric, or one of the following special characters: ^ ! $ x { } ?
@ # % \ or _. For example, the following values are valid substitution
variables:
&VARIABLE1
&DEPARTMENT_NUMBER

A substitution variable can appear anywhere in a query, and its value can be
anything that you might write in a query (except a comment). For example,
you can use a substitution variable in place of a column name, search
condition, subquery, or any specific value.

Running SQL queries with substitution variables
1. Open a new query document and enter this SQL statement:

SELECT * FROM Q.STAFF WHERE DEPT >= &MIN_DEPT
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2. Run the query. The Enter Substitution Variable Values dialog box opens.

3. In the Value field enter a value of 50 and click OK. The query runs and
displays the query results.

Try experimenting with substitution variables by replacing values in the
SELECT and FROM clauses. See what results your queries return with
different inputs.

Saving and Opening SQL queries

You can save queries on your PC, on a file server, or at a database server.

Saving SQL queries to files
1. From an open query, click the Save button on the toolbar.

If the query has been saved before, it is saved again. If the query has not
been previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the query stored and click OK.
The query is saved.

Opening saved SQL query files
1. Click the Open button on the toolbar.

The Open dialog box opens.
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2. Select the file that you want to open and click OK. The selected query
opens in a new query document.

Saving SQL queries at the database server
Queries saved at the server can be made accessible to other users. If you want
to share your queries with other users, save them at the database server.
1.

From an open query, click the Save at Server button on the toolbar.

The Save Query dialog box opens.

2. Enter an owner, a name, select whether or not to share the saved query
with other users, and click OK. The query is saved at the server.
If a query with this name already exists, you are prompted to overwrite
the previously existing query.

Opening saved SQL queries at the database server
You can open queries that have been saved at the database server.
1.

Click the Open From Server button on the toolbar.

The Open From Server dialog box opens.
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2. Enter a server, owner, and name, and click OK. The SQL query opens.

Printing SQL queries

You can preview and print your SQL queries.

Previewing a query
1. Open a query and activate the SQL view. The SQL statement appears.
2. From the File menu, click Page Setup. The Page Setup dialog box opens.
3. Make any changes you want to the layout of the page and click OK.
4. Click the Print Preview button on the toolbar.

A preview of the printed query appears.

Printing SQL queries
1. Open a query and activate the SQL view. The SQL statement appears.
2. From the File menu, click Page Setup. The Page Setup Dialog box opens.
3. Make any changes you that want to the layout of the page and click OK.
4. Click the Print button on the toolbar.

The query is printed.
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Chapter 3. Working with Prompted Queries

Prompted queries are an easy way for you to create a query by selecting
options from menus and lists. Once you have created a prompted query, you
can save it, or convert it to an SQL query.

Building simple queries

You can easily build simple queries using the prompted query interface.

Opening new prompted queries
v From the File menu, click New Prompted Query. A new prompted query

document opens.

Prompted query action buttons
Edit prompted queries using the query action buttons. A set of buttons
appears above the section that it controls.

Prompted query
action button

Appearance Result

Add Click to add an item to the prompted query.

Edit Click to edit the highlighted item in the
query.

Delete Click to delete the selected item.

Move up and
Move down

Click to move the selected item up and down
in the prompted query.
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Adding tables to prompted queries
1. In the Tables section of the prompted query document, click the Add

button.

The Tables dialog box opens.

2.

Type the owner and name of the table that you want to add and click
Add. The table is added to the query.

Note: You can use patterns to select objects from a list of matching objects.
v Use the percent character (%) to match a string of any length containing

any characters. For example, to list all tables with a name beginning
with the letter A, enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

After you enter a pattern, click Add From List and select a table from the
resulting list.

3. Add any additional table conditions to the query and click Close. The
prompted query document appears with the new tables listed.

Running prompted queries
You run a prompted query the same way that you run an SQL query. Click
the Run Query button on the toolbar.

The prompted query runs.

Building Complex Queries

You can also build more complex queries using the prompted query interface.
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Adding columns to prompted queries
1. In the Column section of the Prompted Query document, click the Add

button.

The Columns dialog box opens.

2. Select the column you want to add and click Add. The column is added to
the prompted query.

3. Add any additional columns to the query and click Close. The Prompted
Query document appears with the new columns listed.

Note: You can apply a summary function to the column by selecting one in
the Function field. Available summary functions include: AVERAGE,
COUNT, MAXIMUM, MINIMUM, and SUM.

Note: You can rename a column in the query by typing a new column name
in the New column name field.

Using sort conditions
Sort conditions are used to specify the way you want to sort the rows in the
query. Rows can be sorted in ascending (A-Z) or descending (Z-A) order.

If you sort your rows by more than one column, the first column is ordered
first, the second column is ordered within the order of the first column, and
so on.
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Adding sort conditions
1. In the Sort conditions section of the Prompted Query document, click the

Add button.

The Sort Conditions dialog box opens.

2. Select the column you want to sort by, the direction in which to sort, and
click Add. The sort condition is added to the prompted query.

3. Add any additional sort conditions to the query and click Close. The
Prompted Query document appears with the new sort conditions listed.

Using row conditions
Many times you want to view only certain rows in a table. To select specific
rows to view, add row conditions. If you do not use row conditions, all the
rows in the table are displayed.

The following row conditions are available:
v Equal to
v Less than
v Less than or equal to
v Greater than
v Greater than or equal to
v Between
v Starting with
v Ending with
v Containing
v NULL
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Row conditions are controlled by the following operators:
v Is
v Is Not

Adding row conditions
1. In the Row conditions section of the Prompted Query document, click the

Add button.

The Row Conditions dialog box opens.

2. Select the parts of the conditional statement and click Add.

Part of the row condition Function

Left side Select the column you want to examine.

Operator Determine the relationship between the left and
right hand sides of the row.

Right side Enter the condition for which you want to check.

The row condition is added to the prompted query.
3. Add any additional row conditions to the query and click Close. The

Prompted Query document appears with the new row conditions listed.

Using multiple tables in prompted queries
You can include information from more than one table in a prompted query.

You must relate the two tables, specifying one or more join conditions in each.
Only rows from the tables where join columns are equal are included in the
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results. The data type of each column in a join condition must match. Once
you have specified a relationship between two columns, QMF for Windows
remembers the relationship, and suggests it in future queries, making the
creation of subsequent queries simpler and more efficient.

Creating prompted query join conditions
1. In the Tables section of the Prompted Query Window click the Addbutton

to add at least two tables. If you have never joined the tables before, the
Join Tables dialog box opens. If you have, QMF for Windows suggests the
join condition that you used previously.

2. Select a column with the same data type from each table and click Add.
The new join condition appears in the prompted query.

Prompted queries and SQL

You can use the prompted query interface to learn SQL.

Viewing SQL for prompted queries
From the prompted query view, click the View SQL button on the toolbar.

The equivalent SQL statement for the prompted query appears. You cannot
modify the SQL statement from this view.

Converting prompted queries to SQL
You can convert a prompted query to a new SQL query document. The new
SQL query can be modified, saved, printed, and run. From the Query menu,
click Convert to SQL. The query is converted into a new SQL query
document.
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Using Substitution Variables in Prompted Queries

Substitution variables can be used in a prompted query in the same way as in
an SQL query. See “Substitution Variables in SQL Queries” .

For example, substitution variables can be used in:
v a row condition

DEPT Is Greater Than Or Equal To &MinDept

v a column specification
&InputNum

Saving Prompted Queries

Prompted queries can be saved in files on your PC, on a file server, or at a
database server.

Saving prompted queries to files
1. From an open prompted query, click the Save button on the toolbar.

Note: If the query has been saved before, it is saved again. If the query
has not been previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the prompted query stored and
click OK. The query is saved.

Opening saved prompted query files
1. Click the Open button on the toolbar.

The Open dialog box opens.
2. Select the file you want to open and click OK. The selected prompted

query opens in a new query document.

Saving prompted queries at the database server
1. From an open prompted query, click the Save at Server button on the

toolbar.
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The Save Query dialog box opens.

2. Enter an owner, a name, select whether or not to share the saved query
with other users, and click OK. The query is saved at the server.
If a query with this name already exists, you are prompted to overwrite
the existing query.

Opening saved prompted queries at the database server
You can open prompted queries that have been saved at the database server.
1.

Click the Open From Server button on the toolbar.

The Open From Server dialog box opens.

2. Enter a server, owner, and name, and click OK. The prompted query
opens.

Printing Prompted Queries

You can print your prompted query. You can also print the SQL text of a
prompted query. See “Printing SQL queries” on page 13.

Previewing prompted queries
You can preview the results or text of a prompted query before you print it.
1. Open a query and activate the prompted view. The query appears.
2. From the File menu, click Page Setup. The Page Setup dialog box opens.
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3. Make any changes you want to the layout of the page and click OK.
4. Click the Print Preview button on the toolbar.

A preview of the printed query appears.

Chapter 3. Working with Prompted Queries 23



24 QMF: Getting Started with QMF for Windows



Chapter 4. Working with Query Results

You can apply formatting, grouping, and aggregation directly to query results.
This formatting can be saved with the query, or exported as a form.

Sorting and sizing query results

Users can select, resize, reorder, and sort the data results from a query.

Selecting columns and rows
Once you have run a query, you can use the controls in the Results view to
edit and select information.

Column and row selectors Appearance Function

Row selector Click to select all the data in a row.

Column selector Click to select all the data in a
column.

Cell Click directly on the cell to select it.

Scroll-to-bottom and
Scroll-to-top buttons

Click to scroll to the top or bottom
of a set of query results.

Resizing columns and rows
You can change the appearance of a set of query results by resizing its
columns and rows.
1. Using the mouse select the black dividing line between two columns or

two rows.
2. Drag the divider line from side to side or up and down to resize the

column or row.

Note: If you save the query after resizing its rows or columns, that query
is always displayed using the new formatting.

Auto fitting columns and rows
You can automatically size columns and rows to fit the data they contain.

Using the mouse, select an entire column or row and double-click on the
black dividing line between it and the adjacent object. The column or row is
automatically resized to fit its data.
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Note: If you save the query after resizing its rows or columns, that query is
always displayed using the new formatting.

Sorting query results
Once you have run a query, you can sort the results alphabetically by column.

From the Results view of a query, select a column and select Sort Ascending
from the Results menu.

The query results are sorted in ascending order.

-or-

From the Results view of a query, select a column and select Sort
Descending from the Results menu.

The query results are sorted in descending order.

Note: To apply more complex sorting to the selected column, select Sort from
the Results menu.

Reordering columns
You can change the order of columns in the query results.

From the Results view of a query, select a column and drag it to its new
location.

The column appears in the new order.

Formatting query results

You can change the font used to display queries and query results. The choice
of fonts varies according to what has been installed on your computer. For
more information on adding fonts, refer to your operating system’s help
facility.

Note: If you save the query after selecting a new query results display font,
those results are always displayed using the new font.

Selecting the query results display font
1. From the Results view, select Set Font from the Results menu. The Font

dialog box opens.
2. Select the font and type size for displaying the results of the query and

click OK. The query results are displayed in the format that you specified.
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Note: Click Set As Default to use the selected font as the default font for
all query results.

Formatting numeric query results
1. From the Results view, select a column containing numeric values and

select Format from the Results menu. The Format dialog box opens.
2. Specify the formatting that you want to apply and click OK. The values

are formatted according to your selection.

Note: Click Set As Default to use the selected font as the default font for
all query results.

Converting query results formatting to a form
You can convert query results formatting to a form.
1. From the Results menu, select Display Report.

The Select Form dialog box opens.
2. Select From Queryand click OK.

The query results formatting is converted to a form and opened in a new
form window.

Grouping and aggregating query results

You can apply grouping, aggregation, and summary formatting to query
results.

Grouping query results
You can group query results with or without summary information.
1. Select the column that you want to group.
2. From the Results menu, select the type of grouping that you would like to

apply.
The column is grouped according to your selection.

Summarizing query results
You can summarize query results by column.
1. Select the column that you want to group.
2. From the Results menu, select the type of summary that you would like to

apply.
The column is summarized according to your selection.

Saving query results and formatting

You can save query results and save the formatting as a form.
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Saving query results as a table
You can save query results as a table at a database server.
1. From the Results menu, select Save to Database.

The Save Data dialog box opens.
2. Enter an owner and table name and click OK.

The query results are saved as a table at the database.

Saving query results to files
You can save query results to a file on your PC or a file server.
1. From the Results menu, select Save to File.

The Export Data dialog box opens.
2. Specify the location to which you want to save the file, any export options,

and click OK.
The query results are saved to a file.

Printing query results

You can preview and print your query results.

Previewing query results
1. Open and run a query. The query results appear.
2. From the File menu, select Page Setup. The Page Setup Dialog box opens.
3. Make any changes you want to the layout of the page and click OK.
4. Click the Print Preview button on the toolbar.

A preview of the printed query results appears.

Printing query results
1. Open a query and activate the Results view. The query results appear.
2. From the File menu, select Page Setup. The Page Setup Dialog box opens.
3. Make any changes that you want to the layout of the page and click OK.
4. Click the Print button on the toolbar.

The query results are printed.
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Chapter 5. Working with Reports

Reports are created by combining query results with formatting from a form.

Forms

Forms are sets of formatting instructions used to create, display, and print
reports.

Understanding forms
Forms are composed of a number of components. These components can all
be edited in a form document.

Main The primary components of a form, including headings, footings, and
breaks.

Breaks
Characteristics, content, and placement of up to six subtotal lines in a
report.

Calculations
Report calculation expressions.

Note: You must have IBM’s ObjectREXX installed on your machine to
use form calculations.

Columns
Appearance and formatting of columns in the report. Definable
characteristics include column order, format, usage, indentation, and
width.

Conditions
Conditional formatting constraints. For example, you can set the form
to not display rows that do not meet certain characteristics.

Details
Report detail headings and body text. This is where you can combine
or replace tabular data with free-form text to create form letters or
address labels.

Final Content and placement of your report’s final text. For example, you
can choose to include final text and summary data at the end of the
report.

HTML
Content and placement of HTML tags and formatting in HTML
reports.
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Options
Miscellaneous appearance options for your report.

Page Content and placement of the page heading and footing on your
report.

Producing a report using a form
Reports are created by combining query results with the formatting options
contained in a form. You can produce multiple reports from a single set of
query results by repeating this process.
1. From a query results view, click the Display Report button.

The Select Form dialog box opens.

2. Depending on the type of form you select in the Select From dialog box,
you are asked to provide additional information. Specify the file location
or owner and name, or document title, as appropriate, and click OK. The
report is generated using the selected form and current query results.

Editing a form
The Form window provides many options for editing and formatting forms.

From an open form, display the Form menu. The Form menu lists all your
options for editing and formatting your form. You can also edit any of these
components by clicking the corresponding button on the toolbar.

Creating a form

These steps all include sample data from the table Q.STAFF. Try
experimenting with different settings to create your own custom forms.

Step 1: Create a form
1. Run the following SQL query to retrieve the data to display in the report:

SELECT * FROM Q.STAFF ORDER BY DEPT, NAME

The query results appear.
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2. Click the Display Report button on the toolbar. The Select Form dialog
box opens.

3. Specify that you want to use the default form and click OK. QMF for
Windows displays the default report. To make changes to the default
format, click one of the form component buttons on the toolbar. A button
for each form component is displayed on the form toolbar.

Step 2: Change the column order
We want NAME to be the first column in the report and ID to be the second.
The order of the columns is specified in the Columns component of the form.
1. Click Columns... on the Form menu to display the Columns tab of the

Form dialog box.
2. Change the sequence of a column by typing over the existing sequence

value. To make NAME the first column in the report, change its sequence
number (the column in the list labeled Seq) to 1.

3. To make ID the second column in the report, change its sequence number
to 2 and click OK. QMF for Windows displays the report with the new
column order in the Form window.

Step 3: Change the column headings
We want the first column heading to be EMPLOYEE and the second to be
COMMISSION. Column heading text is specified in the Columns component
of the form.
1. Click Columns... on the Form menu to display the Columns tab of the

Forms dialog box.
2. Change the column heading by typing over the existing column heading

text. Change the first column heading to EMPLOYEE, and the last column
heading to COMMISSION and click OK. QMF for Windows displays the
report with the new column headings in the Form window.

Step 4: Change the column format
We want the SALARY column to be displayed with the appropriate currency
symbol. The format of a column is determined by its edit code, which is
specified in the Columns component of the form.
1. Click Columns... on the Form menu to display the Columns tab of the

Forms dialog box.
2. Change the SALARY column edit code to D2 by typing over the existing

edit code and click OK. QMF for Windows displays the report with the
SALARY column using the appropriate currency symbol in the Form
window.

Step 5: Add summary information
We want to divide the report into separate sections for each department. In
addition, we want to see the total SALARY and COMMISSION for each
department at the end of each section. To do this, we need to specify how we

Chapter 5. Working with Reports 31



want each column in the report to be used. The usage of a column is
determined by its usage code and is specified in the Columns component of
the form.
1. Click Columns... on the Form menu to display the Columns tab of the

Forms dialog box.
2. To divide the report into sections based on DEPT, change the usage code

of DEPT to BREAK1. Usage codes beginning with the word BREAK
produce a section break for the specified column. The number that follows
the word BREAK determines the break level; up to six break levels are
supported in a report.

3. To specify that we want to include a total SALARY and COMMISSION for
each DEPT, change the usage code of SALARY and COMMISSION to
SUM.

4. The report will be easier to understand if we also include descriptive
information at the end of each section break. To do this, click Breaks... on
the Form menu.

5. You specify break footing text on the Breaks tab of the Form dialog box.
Set the first break footing line to Department Total and click OK. QMF for
Windows displays the Form window.

Step 6: Add page headers and footers
We want to add a page heading and footing to our report. Page headings and
footings are specified in the Page component of the form.
1. Click Page... on the Form menu to display the Page tab of the Form dialog

box.
2. The top portion of this dialog is used to specify the page heading. Set the

first line of the page heading to Department Report and the second line to
Total Salary and Commissions. Choose how you want the heading to be
aligned.

3. The bottom portion of this dialog is used to specify the page footing. Set
the first line of the page footing to End Of Page. Choose how you want
the footing to be aligned and click OK. QMF for Windows displays the
Form window.

Saving forms

You can save forms on your PC, on a file server, or at a database server.

Saving a form to a file
1. From an open form, click the Save button.
2. If the form has been saved before, select Save. If the form has not been

previously saved, the Save As dialog box opens.
3. Enter the name of the file where you want the form stored, and click OK.

The form is saved.
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Opening saved form files
1. Click the Open button on the toolbar.

The Open dialog box opens.
2. Select the file that you want to open and click OK. The selected form

opens in a new form document.

Saving forms at the database server
Forms saved at the server can be made accessible to other users. If you want
to share your forms with other users, save them at the database server.
1.

From an open form, click the Save at Server button on the toolbar.

The Save Form dialog box opens.

2. Enter an owner, a name, select whether or not to share the saved form
with other users, and click OK. The form is saved at the server.
If a form with this name already exists, you are prompted to overwrite the
existing form.

Opening saved forms at the database server
You can open forms that have been saved at the database server.
1.

Click the Open From Server button on the toolbar.
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The Open From Server dialog box opens.

2. Enter a server, owner, and name, and click OK. The form opens.

Printing reports

You can produce printed reports.
1. Open a form and click Page Setup.
2. Make any changes that you want to the layout of the page and click OK.
3. Click Print Report on the File menu.

The report is printed.

Exporting reports

You can export a report to a file.
1. Open a form and click Page Setup.
2. Make any changes that you want to the layout of the page and click OK.
3. Click Export Report on the File menu. The Export Report dialog box

opens.

4. Enter the name of the file where you want the report stored and click OK.
The report is exported.
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Chapter 6. Working with Procedures

Linear procedures enable you to run queries, generate reports, edit data, and
perform other functions by executing a single command. For a complete
listing of all the procedure commands supported by QMF for Windows, refer
to the online help facility.

Procedures with logic, or REXX procedures, are similar to linear procedures,
but contain IBM’s Object REXX prgramming language as well as procedure
commands. Object REXX must be installed locally in order to run procedures
with logic

Running procedures

Procedures are used to execute multiple functions with one command.

Creating a new linear procedure
From the File menu, select New Procedure.

A new procedure document opens.

Creating a new procedure with logic
1. From the File menu, select New Procedure.

A new procedure document opens.
2. Type a REXX comment line as the first line of the procedure. REXX

comment lines begin with /* and end with */
3. Type any QMF procedure commands you want in the procedure. QMF

commands must be entered in uppercase and and enclosed in quote
marks.

4. Type any REXX commands you want in the procedure.

Note: REXX commands are run locally, not at the database server. Object
REXX must be installed locally.

Running a procedure at a database server
1. Open a new procedure document and type in a set of commands, or open

an existing procedure from a file or the database server.
2. Click the Run Procedure button on the toolbar.
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The procedure runs.

Saving procedures

You can save procedures on your PC, on a file server, or at a database server.

Saving procedures to files
1. From an open procedure, click the Save button on the toolbar.

If the procedure has been saved before, the procedure is saved. If the
procedure has not been previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the procedure stored and click
OK. The procedure is saved.

Opening a saved procedure file
1. Click the Open button on the toolbar.

The Open dialog box appears.
2. Select the file you want to open and click OK. The selected procedure

opens in a new procedure document.

Saving a procedure to the database server
1.

From an open procedure, click the Save at Server button on the toolbar.
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The Save Procedure dialog box opens.

2. Enter an owner, a name, select whether or not to share the saved
procedure with other users, and click OK. The procedure is saved at the
server.
If a procedure with this name already exists, you are prompted to
overwrite the previously existing procedure.

Opening saved procedures at the database server
You can open procedures that have been saved at the database server.
1.

Click the Open From Server button on the toolbar.

The Open From Server dialog box opens.

2. Enter a server, owner, and name and click OK. The procedure opens.

Printing procedures

You can print the text of a procedure.

Previewing a procedure
1. Open a procedure. The procedure commands appear.
2. From the File menu, click Page Setup. The Page Setup Dialog box opens.
3. Make any changes you want to the layout of the page and click OK.
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4. Click the Print Previewbutton on the toolbar:

A preview of the printed procedure appears.

Printing a procedure
1. Open a procedure. The procedure commands appear.
2. From the File menu, click Page Setup. The Page Setup Dialog box opens.
3. Make any changes you that want to the layout of the page and click OK.
4. Click the Print button on the toolbar:

The procedure is printed.
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Chapter 7. Working with Lists

Lists provide you with an easy way to view collections of QMF objects.

Objects

QMF for Windows recognizes four types of objects: queries, forms,
procedures, and tables. You can use the List window to view the objects based
on the object name, owner, and type.

Listing objects
1. From the File menu, select New List.

The List window opens.

2. Specify an owner and a name.

Note: You can use patterns to select objects from a list of matching objects.
v Use the percent character (%) to match a string of any length containing

any characters. For example, to list all tables with a name beginning
with the letter A, enter A%.
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v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

3. Select the type of object for which you are searching.
4. Click Refresh List. A list of matching objects saved at the database server

is displayed.

List window commands

Right-clicking on an object in the List window displays a list of commands
identical to those in the List menu.

Display object
Opens the selected object for viewing. Available for queries, forms,
procedures, and tables.

Run object
Runs the selected object. Available for queries and procedures.

Draw object
Creates a query based on the selected table. You can choose to draw
an SQL SELECT query, an SQL UPDATE query, an SQL INSERT
query, or a prompted query. Available for tables.

Edit object
Opens the selected object for editing. Available for tables.

Properties
Displays the properties of the selected object, including comments,
attributes, and historical usage information. Available for queries,
forms, procedures, and tables.

Creating lists

You can create lists to serve as collections of objects. For example, you could
create a list of all inventory related queries, forms, procedures and tables to
keep your work in one place. Once created, you can add and remove objects
from the list and save the list for future use.

Adding objects to lists
You can add objects to lists.

From an open list, specify the owner and name information of the objects that
you want to add and click the Add to List button on the toolbar.
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The objects matching the owner and name are added to the list.

Removing objects from lists
You can remove unrelated objects from lists.

From an open list, click the Remove button on the toolbar.

The object is removed from the list, but is not deleted.

Saving lists to files
1. From an open list, click the Save button on the toolbar.

If the list has been saved before, the list is saved. If the list has not been
previously saved, the Save As dialog box opens.

2. Enter the name of the file where you want the list stored and click OK.
The list is saved.

Opening saved list files
1. Click the Open button on the toolbar.

The Open dialog box opens.
2. Select the file that you want to open and click OK. The selected list opens

in a list document.
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Chapter 8. Working with Job Files

You can schedule and run procedures using job files. Job files use the
Windows scheduler to run procedures according to your preset time and date.

Job files

You can create job files and store them locally or at the database server.

Creating job files
1. From the Filemenu, select New Job.

A new job document opens.

Running job files
You can run job files that have been saved locally.
1. Open a job file.
2. Click the Run Job button on the toolbar.

3. Drag the divider line from side to side or up and down to resize the
column or row.

Note: If you save the query after resizing its rows or columns, that query
is always displayed using the new formatting.

Auto fitting columns and rows
You can automatically size columns and rows to fit the data they contain.

Using the mouse, select an entire column or row and double-click on the
black dividing line between it and the adjacent object. The column or row is
automatically resized to fit its data.

Note: If you save the query after resizing its rows or columns, that query is
always displayed using the new formatting.

Sorting query results
Once you have run a query, you can sort the results alphabetically by column.

From the Results view of a query, select a column and select Sort Ascending
from the Results menu.
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The query results are sorted in ascending order.

-or-

From the Results view of a query, select a column and select Sort
Descending from the Results menu.

The query results are sorted in descending order.

Note: To apply more complex sorting to the selected column, select Sort from
the Results menu.

Reordering columns
You can change the order of columns in the query results.

From the Results view of a query, select a column and drag it to its new
location.

The column appears in the new order.

Formatting query results

You can change the font used to display queries and query results. The choice
of fonts varies according to what has been installed on your computer. For
more information on adding fonts, refer to your operating system’s help
facility.

Note: If you save the query after selecting a new query results display font,
those results are always displayed using the new font.

Selecting the query results display font
1. From the Results view, select Set Font from the Results menu. The Font

dialog box opens.
2. Select the font and type size for displaying the results of the query and

click OK. The query results are displayed in the format that you specified.

Note: Click Set As Default to use the selected font as the default font for
all query results.

Formatting numeric query results
1. From the Results view, select a column containing numeric values and

select Format from the Results menu. The Format dialog box opens.
2. Specify the formatting that you want to apply and click OK. The values

Note: Click Set As Default to use the selected font as the default font for
all query results.
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Converting query results formatting to a form
You can convert query results formatting to a form.
1. From the Results menu, select Display Report.

The Select Form dialog box opens.
2. Select From query and click OK.

The query results formatting is converted to a form and opened in a new
form window.

Grouping and aggregating query results

You can apply grouping, aggregation and summary formatting to query
results.

Grouping query results
You can group query results with or without summary information.
1. Select the column that you want to group.
2. From the Results menu, select the type of grouping that you would like to

apply.
The column is grouped according to your selection.

Summarizing query results
You can summarize query results by column.
1. Select the column that you want to group.
2. From the Results menu, select the type of summary that you would like to

apply.
The column is summarized according to your selection.

Saving query results and formatting

You can save query results and save the formatting as a form.

Saving query results as a table
You can save query results as a table at a database server.
1. From the Results menu, select Save to Database.

The Save Data dialog box opens.
2. Enter an owner and table name and click OK.

The query results are saved as a table at the database.

Saving query results to files
You can save query results to a file on your PC or a file server.
1. From the Results menu, select Save to File.

The Export Data dialog box opens.
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2. Specify the location to which you want to save the file, any export options,
and click OK.
The query results are saved to a file.

Printing query results

You can preview and print your query results.

Previewing query results
1. Open and run a query. The query results appear.
2. From the File menu, select Page Setup. The Page Setup Dialog box opens.
3. Make any changes you want to the layout of the page and click OK.
4. Click the Print Preview button on the toolbar:

A preview of the printed query results appears.

Printing query results
1. Open a query and activate the Results view. The query results appear.
2. From the File menu, select Page Setup. The Page Setup Dialog box

appears.
3. Make any changes that you want to the layout of the page and click OK.
4. Click the Print button on the toolbar.

The query results are printed.
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Chapter 9. Working with static queries

A static query is an SQL query that has been previously passed to a database
server and bound into a package. When a static query is run, the database
server uses the SQL text bound in the package, rather than the SQL text
currently appearing in the query window. Static queries are more resource
efficient than dynamic queries, but static queries cannot be edited.

Static queries

Static queries are created from previously existing SQL and prompted queries.

Creating static queries
1. From the Query menu, select Bind Static Package. The Bind Static

Package dialog box opens.

2. Select the Package tab, enter a collection ID and package name and change
any other desired options.

3. If the query contains any substitution variables, select the Variables tab.
Replace any substitution variables with host variables.

4. Click OK. The static query is bound.
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Note: After you bind a query, you must also save that query either to a
file or to the database server.

Replacing substitution variables with host variables
When you bind a package, you must specify a host variable to use in place of
each substitution variable in the SQL text. However, a substitution variable
cannot always be directly replaced by a host variable. Substitution variables
provide direct text substitution in the query text before the text is sent to the
database server. Host variables are sent as part of the query to the database
server. Refer to the documentation for your database server for rules on where
and how host variables can be used in queries.

After you specify a relationship between a substitution variable and a host
variable, QMF for Windows remembers the relationship, and suggests it in
future queries, making binding packages simpler.

The valid data types for host variables are:
v CHAR(n)
v VARCHAR(n)
v INTEGER
v SMALLINT
v FLOAT
v DECIMAL(p,s)
v DATE
v TIME
v TIMESTAMP
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1. From the Bind Static Package dialog box, select the Input Variables tab.

2. Enter the type of variable for each host variable and click OK. The
substitution variables are converted to host variables.

Running a static query
You run static queries as you would any other queries. See “SQL Queries” on
page “SQL queries” on page 7.
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Chapter 10. Working with the Table Editor

Use the table editor to search for, add, edit, or delete data stored in your
tables without having to write SQL statements.

Table editor

The table editor gives you flexibility in editing and searching your data.

Searching for rows using the table editor
1. From the File menu, select Table Editor. The Table Editor dialog box

opens.

2. Specify a table.

Note: You can use patterns to select table names from a list of matching
tables.

v Use the percent character (%) to match a string of any length containing
any characters. For example, to list all tables with a name beginning
with the letter A, enter A%.

v Use the underscore character (_) to match a single character. For
example, to list all tables with an owner that has the letter A in the
second position, enter _A%.

Once you have entered a pattern, click List Tables and select a table from
the resulting list.

3. Select a Save Mode.
v Immediate - The table is updated at the database server immediately

after each change.
v End - The table is updated at the database server after you finish

entering all changes. Other users will not be able to make changes to
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the table while you are making your changes.

4. Click Edit. The Edit table dialog box opens.
5. Enter the values for which you want to search in the Value column, or

type search criteria in the Additional search criteria field to specify more
complex search conditions. You can enter any valid SQL predicate in the
Additional search criteria field.

6. Click Start Search. The first matching row is displayed in the Value
column.

Adding a row
1. In the Edit Table dialog box, enter the information for the new record.
2. Click Insert Row. The new row is added to the table.
3. Click OK. Your changes are saved.

Changing a row
1. From the Edit Table dialog box, search for the row you want to change.
2. Click Next Row until the row you want to change is displayed.
3. Edit the data in the Value column and click Update Row. The row is

updated.
4. Click OK. Your changes are saved.

Deleting a row
1. From the Edit Table dialog box, search for the row that you want to delete.
2. Click Next Row until the row you want to delete is displayed.
3. Click Delete Row. The row is deleted.
4. Click OK. Your changes are saved.
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Editing tables from the query results view

You can edit tables directly from the query results view.

Deleting a row from the query results view
You can delete individual rows from tables in the query results view.

From the query results view, select a row and select Delete from the Edit
menu. The row is deleted.

Updating columns from the query results view
You can update the contents of individual columns in the query results view.

From the query results view, double click on a cell, enter a new value, and
press Enter. The table is updated.

DB2 Forms

If you have the DB2 Forms User component installed on your machine, you
can use it as the table editor for tables that do not contain LOB data. For more
information on DB2 Forms, please visit the Resource Center for DB2 Forms at
www.rocketsoftware.com/db2forms.
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Chapter 11. Distributing Data

You can export your data to other databases and applications.

Exporting data

You can export data from QMF for Windows into other applications in the
following ways:
v Export the data into a Text, CSV, IXF, or HTML file
v Save query results to a table
v Add query results directly into a Microsoft Excel spreadsheet

Exporting data to files
1. While viewing query results, select Export Data on the File menu. The

Export Data dialog box opens.

2. Select the desired Output File Type and click the Options button.
Depending on the type of output file you select, either the Export
Text⁄DEL Options dialog box, the Export HTML Options dialog box, the
Export IXF Options dialog box, or the Export CSV Options dialog box
opens.
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v You can produce a text file with a .TXT extension. This is a standard
ASCII file with optional string and column delimiters (as specified in
the Export Text⁄DEL Options dialog box).

v You can produce an HTML file with an .HTM extension file. This is an
HTML file that can be viewed by any web browser. All of the HTML
tags are automatically generated in the file; it is ready to be published
on your Internet or intranet web site. The options you choose on the
Export HTML Options dialog box control the appearance of the
exported data.

v You can produce a .IXF file. An IXF export preserves all database
information, including column headings and data types. It is typically
used to transfer information from one database to another.

v You can produce a .CSV file. A CSV export is very similar to a text
export, using a comma as the column delimiter. This format is most
commonly used by spreadsheet applications.

3. Select the options for the selected type of export file and click OK. The
Options dialog box closes.

4. Click OK on the Export Data dialog box. The data is exported.

Importing data
You can import data that has been saved in a IXF file. Once data is imported
into a query window, it can be saved to a database server, exported to a new
file, or used for reports. PC⁄IXF and character mode System⁄370 IXF files are
supported.
1. From the File menu, select Import Data. The Import Data dialog box

opens.

2. Select the file you want to import and click OK. The imported data is
displayed in a new query window.

Saving data to a database server
You can save imported query results to a database table.
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1. While viewing imported query results, select Save Data on the File menu.
The Save Data dialog box opens..

2. Select a database server, enter a table owner and name, choose any other
desired options, and click OK. The data is saved.

Using the Send To command

QMF for Windows includes a Send To command and a basic email client. You
can use the Send To command in conjunction with job files to schedule
queries and distribute their results.
1. From the File menu, select Send To and Internet Mail Recipient. The

Message dialog box opens.
2. Specify a message recipient, a subject, the text of the message, and click

Next. The Attachments dialog box opens.
3. Add or remove any attachments to the message and click Next. The Send

Message dialog box opens.
4. Specify the name of your mail server and click Finish. The message is

sent.
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Using the Microsoft Excel Add-In

QMF for Windows includes an add-in for Microsoft Excel 7.0 or later. These
add-ins enable you to run QMF for Windows from Excel and return query
results directly into a spreadsheet. The appropriate add-in is automatically
installed if you choose the "Typical" installation option, or if you choose the
"Custom" installation option and select the Microsoft Excel Add-In option.
1. Click the QMF for Windows button on the Excel toolbar.

QMF for Windows opens.
2. From QMF for Windows, select and run a query. The query results appear.
3. Select the data you want to return to Excel.
4. From the File menu, select Return data to Microsoft Excel. Excel opens

and displays the QMF for Windows Add-In dialog box.
5. Enter the destination range for the data and click OK. The data is added

to the spreadsheet.

Using Sample Applications

Several sample applications and integration solutions are available for QMF
for Windows. Visit the IBM web site at http:⁄⁄www.ibm.com⁄qmf⁄ to find out
more.
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Chapter 12. Using QMF Report Center

QMF Report Center lets you produce custom reports by using shared QMF
queries, forms, procedures, and tables. With quick access to these objects, you
can specify data format preferences and produce custom reports that can be
viewed and manipulated in a variety of applications.

Getting Started in QMF Report Center

v Right-click on any object or folder to activate the same options that are
available from the toolbar menus.

v Click the plus symbol (+) next to any folder to open the first level of
contents. Hold the SHIFT key while clicking the plus symbol (+) to open all
levels beneath the folder.
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QMF Report Center Window
The QMF Report Center window contains a tree-like structure of available
Favorites, DB2 servers, Public Favorites, objects, and a Recycle Bin.

Objects displayed in this window include an icon that represents the type of
application with which the object output is associated.
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Connecting to the Server
1. If no server names are displayed beneath DB2 Servers, click the plus

symbol (+).
2. Click the plus symbol (+) next to a server. The Filter Options dialog box

opens.

3. Select the object types that you want to see, then click OK. The available
objects on the server are displayed, grouped by object type.

Working with Reports and Objects

Reports are based on QMF objects. All items contained in your personal and
Public Favorites folders are considered reports; you can manipulate formatting
and display options for these items. The items contained in these Favorites
folders link to the QMF objects that reside on the server. You do not actually
modify a QMF object, you modify the link to the object that is referred to as a
report. Since reports are based on objects, properties of objects also apply to
reports.

You can create reports from objects that reside on a server; however, they are
not saved to the server. This functionality allows you to quickly create
one-time reports. After creating a report from objects on a server, however,
you are given the option to save the report to your Favorites folder.
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Running Reports
You can run reports from your Favorites folders or from objects located on the
server.
1. With the report or object selected, choose Propertiesfrom the Report menu.

The Report Properties dialog box opens.

2. Define properties, if desired.
3. Click the Run button. The report is processed and, if you selected the View

report after publishing option in the Report Properties Output dialog box,
the report is displayed in the application you specified.

You can also quickly run a report by any of the following methods:
v Select the report, then choose Run from the Report menu.
v Right-click on the report, then choose Run.
v Double-click on the report name.

Working with Folders and Favorites

Folders are used to group reports and QMF objects; folders are named
according to object owner names. You can perform the same operations on
folders that you do on reports, such as running reports and defining report
properties. Performing these operations on a folder applies the operation to
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every report contained within the folder. For example, if you want to
consecutively run every report contained within a folder, select the folder,
then select Run from the Report menu.

QMF Report Center contains two top-level folders in which you can store
reports. The folders contain reports that point to objects on servers; the objects
themselves are not contained within the Favorites folders. Your personal
Favorites folder resides locally (on your PC), so you are the only user who
can access the folder and its contents. The Public Favorites folder resides on
the server and can be accessed by all authorized users. You may have access
to several Public Favorites folders, depending on your resource limits, though
there will never be more than one public Favorites folder on each server.

When you copy QMF objects to the Favorites folders, the folders are
automatically renamed to include the object type and owner name. When you
copy an entire object type (i.e., folder of same-type objects) from a server (e.g.,
all queries), the server name is also included in the new folder name.

Adding Reports to Favorites
You can add any object or report from a server to your personal Favorites
folder, or to the Public Favorites folder on a server (provided you have been
granted permission by your system administrator).

To add reports to personal Favorites:

With the report or object selected, choose Add to favoritesfrom the Report
menu, or drag the report or object to your personal Favorites folder. A report
is added to the top of your personal Favorites folder with the following
naming convention: ObjecttypeOWNERNAME.OBJECTNAME.

To add reports to Public Favorites:

Drag the QMF object or report to the Public Favorites folder on a server. You
can add reports from your personal Favorites folder or from any server.

Note: When adding to Public Favorites or modifying reports in Public
Favorites, you must select Save changes to Public Favorites from the
Report menu before your updates are saved to the server.

For more information on using QMF Report Center, see the online help
system.
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Chapter 13. Using the QMF for Windows API

You can create custom applications using the QMF for Windows application
programming interface.

Controlling QMF for Windows through the API

The following steps provide an overview of how you work with the API to
control QMF for Windows.
1. Create an instance of the QMF for Windows API object. If you are using

Microsoft Visual Basic, add a reference to the QMF for Windows type
library, qmfwin.tlb. Then use the Dim statement:
Dim QMFWin As New QMFWin

Or the CreateObject statement:
Dim QMFWin As Object

Set QMFWin = CreateObject ("QMFWin.Interface")

Note: If you are using a different development environment, refer to your
product documentation on how to complete this step.

2. Select the DB2 server you want to use and call InitializeServer() to
initialize a connection to the database.

Note: You cannot initialize a server until a user ID and password are
validated by DB2. You can have QMF for Windows prompt for the
user ID and password, or you can prompt for them in your
application and pass them as parameters in the InitializeServer()
function call.

3. Select the query you want to run using InitializeQuery(). If the query
contains variables, use the SetVariable() function to set the variable values.

4. Open or execute the query. Use the Open() function to open the query’s
cursor for SELECT statements, and use the Execute() function to execute
the SQL for non-SELECT statements.

5. If the query is a SELECT statement, fetch rows of data by repeatedly
calling FetchNextRow(). To fetch more than one row at a time, use
FetchNextRows(), or use CompleteQuery() to direct QMF for Windows to
fetch all of the rows.

6. If the query is a SELECT statement, close the query by using the Close()
function.

7. Terminate the unit-of-work using the Commit() or Rollback() functions.
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Blocking calls
All of the QMF for Windows API functions are synchronous. This means that
they block, or do not return, until the requested database action completes.
This implementation is desirable because it simplifies programming in the
client application. However, if your client application is single-threaded, it
cannot respond to user input or perform screen refreshes while it is waiting
for a QMF for Windows API function to return.

The QMF for Windows API responds to one function call at a time from a
client. If your client application is multi-threaded, you must:
v wait for one function call to complete before making another, or
v create multiple instances of the QMF for Windows API (one for each thread

using the API).

Connecting to the database
Each instance of the QMF for Windows API object creates and uses a single
connection to the database for all database activity that is subject to a
subsequent rollback or commit, including opening a query, fetching data, and
executing SQL statements.

If you create more than one query in a given instance of the QMF for
Windows API object by calling InitializeQuery() two or more times, all the
queries share the same single connection.

The QMF for Windows API responds to one function call at a time from a
client. If your client application is multi-threaded, you must:
v DeleteQMFObject()
v GetQMFObjectInfo()
v GetQMFObjectInfoEx()
v GetQMFObjectList()
v GetQMFObjectListEx()
v GetQMFQueryText()
v SaveQMFQuery()

QMF for Windows creates and uses a second connection to the database in
order to handle administrative database activity (for example, retrieving QMF
information). This second connection is necessary to support a consistent
rollback and commit mechanism for client applications.

The QMF for Windows API object automatically handles these connections to
the database. However, if your system administrator has established a limit
for the number of connections allowed, remember that each instance of the
QMF for Windows API object may use two connections.
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API Reference

This reference lists all the available commands for creating applications using
the QMF for Windows API.

AddDecimalHostVariable()
short AddDecimalHostVariable(long QueryID, short Type, short Precision, short
Scale, const VARIANT& Value)

Description
This function applies the data in Value to a variable in the static SQL
statement initialized with QueryID. You call this function for each variable in
the statement. QMF for Windows makes no attempt to match values to
variables, so you must call this function in the same order as the variables in
the SQL statement.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeStaticQuery().

Type The SQL data type of the value to be passed to the database
server. This value influences the conversion of Value from a
VARIANT data type to the value actually passed. The only
valid value for AddDecimalHostVariable() is 484
(RSDT_DECIMAL).

Precision The precision of the decimal value.

Scale The scale of the decimal value.

Value The data value to substitute in the statement. To specify a null
value, the type of the variant should be set to VT_EMPTY.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

AddHostVariable()
short AddHostVariable(long QueryID, short Type, const VARIANT& Value)

Description
This function applies the data in Value to a variable in the static SQL
statement initialized with QueryID. You must call this function for each
variable in the statement. QMF for Windows makes no attempt to match
values to variables, so you must call this function in the same order as the
variables in the SQL statement.
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Parameters

Name Description

QueryID The ID of the query as returned from InitializeStaticQuery().

Type The SQL data type of the value to be passed to the database
server. This value influences the conversion of Value from a
VARIANT data type to the value actually passed.

Value The data value to substitute in the statement. To specify a null
value, the type of the variant should be set to VT_EMPTY.

Valid values for Type include:

Value Meaning

384 (RSDT_DATE) Date

388 (RSDT_TIME) Time

392 (RSDT_TIMESTAMP) Time stamp

448 (RSDT_VARCHAR) Variable length character string

452 (RSDT_CHAR) Character string

464 (RSDT_VARGRAPHIC) Variable length graphic

468 (RSDT_GRAPHIC) Graphic

480 (RSDT_FLOAT) Floating point number

496 (RSDT_INTEGER) 4-byte integer

500 (RSDT_SMALLINT) 2-byte integer

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

BindDecimalHostVariable()
short BindDecimalHostVariable(BSTR CollectionName, BSTR PackageName, short
SectionNumber, short Number, BSTR Name, short DataType, short Precision, short
Scale)

Description
This function binds a variable in the specified section. Include the text ″:H″ in
the SQL text as a placeholder for a host variable. For each decimal host
variable in the SQL text, you must call BindDecimalHostVariable() to specify
information about the variable.
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Parameters

Name Description

CollectionName The collection ID of the package you want to bind.

PackageName The name of the package you want to bind.

SectionNumber The section number of the statement within the collection and
package you want to bind.

Number The identifier for the variable you want to bind. The first
variable in the SQL statement is variable 0, etc.

Name Used by the database server for diagnostic purposes. This value
is not validated nor required by QMF for Windows.

DataType The SQL data type of the variable. The only valid value for
BindDecimalHostVariable() is 484 (RSDT_DECIMAL).

Precision The precision of the decimal value.

Scale The scale of the decimal value.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

BindHostVariable()
short BindHostVariable(BSTR CollectionName, BSTR PackageName, short
SectionNumber, short Number, BSTR Name, short DataType, short Length)

Description
This function binds a variable in the specified section. Include the text ″:H″ in
the SQL text as a placeholder for a host variable. For each host variable in the
SQL text, you must call BindHostVariable() to specify information about the
variable.

Parameters

Name Description

CollectionName The collection ID of the package you want to bind.

PackageName The name of the package you want to bind.

SectionNumber The section number of the statement within the collection and
package you want to bind.

Number The identifier for the variable you want to bind. The first
variable in the SQL statement is variable 0, etc.

Name Used by the database server for diagnostic purposes. This value
is not validated nor required by QMF for Windows.
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DataType The SQL data type of the variable.

Length The length of the variable.

Valid values for DataType include:

Value Meaning

384 (RSDT_DATE) Date

388 (RSDT_TIME) Time

392 (RSDT_TIMESTAMP) Time stamp

448 (RSDT_VARCHAR) Variable length character string

452 (RSDT_CHAR) Character string

464 (RSDT_VARGRAPHIC) Variable length graphic

468 (RSDT_GRAPHIC) Graphic

480 (RSDT_FLOAT) Floating point number

484 (RSDT_DECIMAL) Decimal

496 (RSDT_INTEGER) 4-byte integer

500 (RSDT_SMALLINT) 2-byte integer

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

BindSection()
short BindSection(BSTR CollectionName, BSTR PackageName, short
SectionNumber, BSTR SQLText)

Description
This function sets the SQL text to be used in the specified section number of
the collection and package during binding.

Parameters

Name Description

CollectionName The collection ID of the package you want to bind.

PackageName The name of the package you want to bind.

SectionNumber The section number of the statement within the collection and
package you want to bind.

SQLText The SQL text for the statement you want to bind.

70 QMF: Getting Started with QMF for Windows



Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

CancelBind()
short CancelBind(BSTR CollectionName, BSTR PackageName)

Description
This function cancels a previously initialized bind operation. All information
regarding the named package is released.

Parameters

Name Description

CollectionName The collection ID of the package you want to bind.

PackageName The name of the package you want to bind.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

ChangePassword()
short ChangePassword(BSTR NewPassword)

Description
This function changes the password for the user ID previously specified on
the InitializeServer() call.

Note: Not all types of database servers support changing passwords. If the
server specified on the InitializeServer() call does not support changing
passwords, an error is returned, and the password is not changed.

Parameters

Name Description

NewPassword The new password.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

ClearList()
short ClearList(short Type)
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Description
This function re-initializes the internal list specified by the Type parameter.

Parameters

Name Description

Type Either the value RSL_SERVER or RSL_QUERY.

Return Value
Zero if successful, RS_ERROR_OUTOFRANGE if unsuccessful.

Related Topics
Open()

Close()
short Close(long QueryID)

Description
This function closes a query and invalidates QueryID. If there is a cursor open
for the query, the cursor is closed, freeing the database for other users. This
function does not terminate the connection to the database server. Since the
connection remains open, no rollback or commit is performed.

Note: The name of this function conflicts with the Microsoft Access 2.0
keyword Close. If you are using MS Access 2.0, place square brackets [
] around the function name.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
Execute()
Open()

Commit()
short Close(long QueryID)
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Description
This function commits any changes you made in the current unit of work,
ends the current unit of work, closes any open cursors, and invalidates all
outstanding Query IDs.

Note: The name of this function conflicts with the Microsoft Access 2.0
keyword Commit. If you are using MS Access 2.0, place square brackets
[ ] around the function name.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
Rollback()

CompleteQuery()
short CompleteQuery(long QueryID)

Description
This function fetches all rows of a result set and stores them internally in
QMF for Windows. If there is a cursor open for the query, the cursor is closed,
freeing the database for other users. You can use FetchNextRow() or
FetchNextRows() to retrieve the rows. Call Close() when you are done with
this query.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

CopyToClipboard()
short CopyToClipboard(long QueryID, long FirstRow, long FirstCol, long
LastRow, long LastCol, BOOL IncludeColHeadings, [VARIANT DateTimeFomat])

Description
This function copies the specified range of rows and columns to the
Clipboard. If you have not retrieved row data for all of the rows that you
want to copy to the Clipboard, you call CompleteQuery() prior to calling this
function. An error message is returned if you attempt to copy rows that have
not been retrieved from the database.
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Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

FirstRow The first row you want to include in the copy.

FirstCol The first column you want to include in the copy.

LastRow The last row you want to include in the copy, or -1 if all rows
are included.

LastCol The last column you want to include in the copy, or -1 if all
columns are included.

IncludeColHeadings Use nonzero to include the column headings in the first row
and zero to not include them.

DateTimeFormat Optionally, the format to use for date and time values. Valid
values are 0 (ISO format), 1 (USA format), 2 (EUR format), 3 (JIS
format), or 4 (Windows Control Panel format). The default
value is 4.

Note: The value of the first row in a result set is 0, and the value of the last
row is one less than the total number of rows. The value of the first
column in a result set is 0, and the value of the last column is one less
than the total number of columns.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information. If the result set is empty, or no rows have been retrieved from
the database, nonzero is returned unless FirstRow=0 and LastRow=1. In this
case, zero is returned and an empty string is copied to the Clipboard.

DeleteQMFObject()
short DeleteQMFObject(BSTR OwnerAndName)

Description
This function deletes a QMF object (query, form, procedure, or table).

Parameters

Name Description

OwnerAndName A string containing the owner and name, separated by a period,
of the object that you want to delete. For example,

John.Query2
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Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

EndBind()
short EndBind(BSTR CollectionName, BSTR PackageName)

Description
This function completes the bind process for a static SQL package. Calling this
function causes QMF for Windows to send the complete information for the
current package to the database for processing.

Parameters

Name Description

CollectionName The collection name used in the previous call to StartBind().

PackageName The package name used in the previous call to StartBind().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Execute()
short Execute(long QueryID)

Description
This function executes an SQL statement that uses an SQL verb other than
SELECT. Use Execute() when the statement does not return any results. For
statements that do return results, use ExecuteEx(). For statements using the
SELECT verb, use Open() instead of Execute() or ExecuteEx(). To determine
the verb used by a query, call GetQueryVerb().

Note: The name of this function conflicts with the Microsoft Access 2.0
keyword Execute. If you are using MS Access 2.0, place square brackets
[ ] around the function name.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().
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Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
Execute()
Open()

ExecuteEx()
short ExecuteEx(long QueryID,VARIANT* Result)

Description
This function executes an SQL statement that uses an SQL verb other than
SELECT. Use ExecuteEx() when the statement returns results, for example,
with a SELECT INTO statement. For statements that do not return any results,
use Execute(). For statements using the SELECT verb, use Open() instead of
Execute() or ExecuteEx(). To determine the verb used by a query, call
GetQueryVerb().

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Result A pointer to a VARIANT in which the result is stored. The
result is an array (variant type VT_ARRAY | VT_VARIANT)
containing one value for each column in the result.

Each value is specified in either its native data type or the
closest variant data type. The supported return types are: string
(variant type VT_BSTR), float (variant type VT_R4), double
(variant type VT_R8), short (variant type VT_I2), long (variant
type VT_I4), and binary (variant type VT_UI1 | VT_ARRAY).

You must properly initialize the VARIANT before calling this
function. Visual Basic does this automatically. Visual C++
programmers must call VariantInit().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

ExecuteStored Procedure()
short ExecuteStoredProcedure(long QueryID,[VARIANT vaCommitOK],
[VARIANT vaMaxResultSets], [VARIANT vaColumnNames], [VARIANT
vaColumnLabels], [VARIANT vaColumnComments])
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Description
This function executes an SQL statement that uses the SQL verb CALL, to run
a stored procedure at the database server. Use ExecuteStoredProcedure() when
the stored procedure does not return any results (instead of or in addition to
result sets). For stored procedures that do return results, use
ExecuteStoredProcedureEx().

To initialize a stored procedure for execution with ExecuteStoredProcedure(),
first call InitializeQuery() specifying an SQL statement that uses the CALL
statement. The stored procedure name must be specified as a literal in the
CALL statement. Any parameters specified in the CALL statement (constant
or otherwise) are ignored. Instead, use AddHostVariable() to specify the input
and output variables.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery(). The SQL
text for the query should specify a CALL statement.

vaCommitOK An optional Boolean value specifying whether the stored
procedure can commit the unit of work or if this operation
should be restricted. The default value is True.

vaMaxResultSets An optional numeric value specifying the maximum number of
result sets that the stored procedure should be allowed to
return. Specify zero if you do not want the stored procedure to
return any result sets or if the database server does not support
returning result sets from stored procedures over DRDA.

vaColumnNames An optional Boolean value specifying whether or not the
database should return column names for the columns in each
returned result set.

vaColumnLabels An optional Boolean value specifying whether or not the
database should return column labels for the columns in each
returned result set.

vaColumnComments An optional Boolean value specifying whether or not the
database should return column comments for the columns in
each returned result set.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.
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ExecuteStored ProcedureEx()
short ExecuteStoredProcedureEx(long QueryID,VARIANT* Result,[VARIANT
vaCommitOK], [VARIANT vaMaxResultSets], [VARIANT vaColumnNames],
[VARIANT vaColumnLabels], [VARIANT vaColumnComments])

Description
This function executes an SQL statement that uses the SQL verb CALL, to run
a stored procedure at the database server. Use ExecuteStoredProcedureEx()
when the stored procedure returns results (instead of or in addition to result
sets). For stored procedures that do return results, use
ExecuteStoredProcedureEx().

To initialize a stored procedure for execution with ExecuteStoredProcedure(),
first call InitializeQuery() specifying an SQL statement that uses the CALL
statement. The stored procedure name must be specified as a literal in the
CALL statement. Any parameters specified in the CALL statement (constant
or otherwise) are ignored. Instead, use AddHostVariable() to specify the input
and output variables.

If the stored procedure returns result sets, call GetStoredProcedureResultSets()
to retrieve the query IDs for the result sets.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery(). The SQL
text for the query should specify a CALL statement.

Result A pointer to a VARIANT in which the result is stored. The
result is an array (variant type VT_ARRAY | VT_VARIANT)
containing one value for each column in the result.

Each value is specified in either its native data type or the
closest variant data type. The supported return types are: string
(variant type VT_BSTR), float (variant type VT_R4), double
(variant type VT_R8), short (variant type VT_I2), long (variant
type VT_I4), and binary (variant type VT_UI1 | VT_ARRAY).

You must properly initialize the VARIANT before calling this
function. Visual Basic does this automatically. Visual C++
programmers must call VariantInit().

vaCommitOK An optional Boolean value specifying whether the stored
procedure can commit the unit of work or if this operation
should be restricted. The default value is True.
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vaMaxResultSets An optional numeric value specifying the maximum number of
result sets that the stored procedure should be allowed to
return. Specify zero if you do not want the stored procedure to
return any result sets or if the database server does not support
returning result sets from stored procedures over DRDA.

vaColumnNames An optional Boolean value specifying whether or not the
database should return column names for the columns in each
returned result set.

vaColumnLabels An optional Boolean value specifying whether or not the
database should return column labels for the columns in each
returned result set.

vaColumnComments An optional Boolean value specifying whether or not the
database should return column comments for the columns in
each returned result set.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Export()
short Export(long QueryID, long FirstRow, long FirstCol, long LastRow, long
LastCol, short Format, short StringDelimiter, short ColumnDelimiter, BOOL
IncludeColHeadings, BSTR FileName, [VARIANT DateTimeFomat])

Description
This function copies the specified range of rows and columns to the
Clipboard. If you have not retrieved row data for all of the rows that you
want to copy to the Clipboard, you call CompleteQuery() prior to calling this
function. An error message is returned if you attempt to copy rows that have
not been retrieved from the database.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

FirstRow The first row you want to include in the export.

FirstCol The first column you want to include in the export.

LastRow The last row you want to include in the copy, or -1 if all rows
are included.

LastCol The last column you want to include in the copy, or -1 if all
columns are included.

Chapter 13. Using the QMF for Windows API 79



IncludeColHeadings Use nonzero to include the column headings in the first row
and zero to not include them.

Filename A string containing the name of the file to which you want to
write the export.

DateTimeFormat Optionally, the format to use for date and time values. Valid
values are 0 (ISO format), 1 (USA format), 2 (EUR format), 3 (JIS
format), or 4 (Windows Control Panel format). The default
value is 4.

Note: The value of the first row in a result set is 0, and the value of the last
row is one less than the total number of rows. The value of the first
column in a result set is 0, and the value of the last column is one less
than the total number of columns.

Name Description

Format Specifies the output format.

Value Meaning

0 (RSEF_TEXT) The output file is written in plain text format.

1 (RSEF_HTML) The output file is written in HTML format, and the
data is organized in an HTML table.

2 (RSEF_CSV) The output file is written in CSV (comma separated
values) format.

3 (RSEF_PCIXF) The output file is written in PC/IXF format.

4 (RSEF_S370IXF) The output file is written in System/370 IXF format.

Name Description

String Delimiter Specifies the string delimiter. This parameter is ignored if
Format is RSEF_HTML.

Value Meaning

0 (RSSD_NONE) No string delimiter is used.

1 (RSSD_SINGLEQUOTE) Strings are delimited by a single quote character (’).

2 (RSSD_DOUBLEQUOTE) Strings are delimited by a double quote character (″).

Name Description

Column Delimiter Specifies the column delimiter. This parameter is ignored if
Format is RSEF_HTML.
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Value Meaning

0 (RSCD_SPACE) Columns are delimited by a space character ( ).

1 (RSCD_TAB) Columns are delimited by a tab character (\t).

2 (RSCD_COMMA) Columns are delimited by a comma character (,).

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information. If the result set is empty, or no rows have been retrieved from
the database, nonzero is returned unless FirstRow=0 and LastRow=1. In this
case, zero is returned and an empty file is written.

Related Topics
CopyToClipboard()

ExportForm()
short ExportForm(BSTR OwnerAndName, BSTR FileName)

Description
This function exports the specified QMF form to the specified file.

Parameters

Name Description

OwnerAndName A string containing the owner and name, separated by a period,
of the form that you want to export. For example,

John.Query2

FileName A string containing the name of the file to which you want to
write the exported form.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
PrintReport()

ExportReport()
short ExportReport(long QueryID, short SourceType, BSTR Source, BSTR
OutputFileName, short PageLength, short PageWidth, BOOL IncludeDateTime,
BOOL IncludePageNumbers, [VARIANT Format], [VARIANT UseFormPageSetup])
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Description
This function creates a report for the specified query and writes it to a file.
You specify the formatting and layout for the report in a QMF form. The
output file is an ASCII text file with each line separated by a pair of carriage
return and line feed characters, and each page separated by a form feed
character. It is best to view the output file using a fixed-pitch font.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Source The name (either a filename or Owner.Name) of the form you
want to use.

OutputFileName The name of the file to which you want to write the report.

PageLength The number of lines on each page of the report. A PageLength
of -1 specifies continuous output (no page breaks unless the
report is wider than PageWidth).

IncludeDateTime Nonzero specifies that the date and time are included at the
bottom of each page. Zero specifies that the date and time are
not included.

IncludePageNumbers Nonzero specifies that page numbers are included at the
bottom of each page. Zero specifies that page numbers are not
included.

Format Optionally, specifies the format of the exported report. If zero,
the format is plain text, specifying that the output should be
exactly that produced by the form (text or HTML, depending
on the type of form). If nonzero, the format is HTML,
specifying that the output should be HTML. With non-HTML
forms, the output is converted to HTML by adding HTML tags
at the beginning and end of the output. The default value is
zero.

DateTimeFormat Optionally, the format to use for date and time values. Valid
values are 0 (ISO format), 1 (USA format), 2 (EUR format), 3
(JIS format), or 4 (Windows Control Panel format). The default
value is 4.

Format The format of the output file.

UseFormPageSetup Optionally, if nonzero specifies that the PageLength, PageWidth,
IncludeDateTime, and IncludePageNumbers parameters should be
ignored, and values for them should instead be taken from the
values saved with the specified form. The default value is zero.

Value Meaning

0 (RSF_DEFAULT) Use the default form. FormName should be an empty
string.
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1 (RSF_DATABASE) Use a form from the database. Specify the form
owner and name (Owner.Name) in the FormName
parameter. To use a form located on a different
database server, first use ExportForm() to export the
form to a file and then specify a SourceType of
RSF_FILE.

2 (RSF_FILE) Use a form contained in a file. Specify the file name
in the FormName parameter.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
ExportForm()

FastSaveData()
short FastSaveData(long QueryID, BOOL Replace, BSTR Tablename, BSTR
TableSpaceName, [VARIANT Comment])

Description
This function creates a report for the specified query and writes it to a file.
You specify the formatting and layout for the report in a QMF form. The
output file is an ASCII text file with each line separated by a pair of carriage
return and line feed characters, and each page separated by a form feed
character. It is best to view the output file using a fixed-pitch font.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Replace Use nonzero if you want the specified data to replace any
existing data in the table. Use zero if you want the specified
data to be appended to any existing data in the table.

TableName The name of the table in which you want to store the data. If
the table does not exist, QMF for Windows creates it.

TableSpaceName The name of the table space in which the table exists or is
created. If TableSpaceName is NULL or an empty string, QMF
for Windows uses the default table space. If you have
configured QMF for Windows to always use the default table
space, this parameter is ignored. See RSR_SDDIFFERENTTS in
the description for GetResourceLimit().

Comment Optionally, a string that specifies a comment for the table in
which the data is saved.
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Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

FetchNextRow()
short FetchNextRow(long QueryID, VARIANT* Row)

Description
This function fetches the next row of data from the database.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Row A pointer to a VARIANT in which the result is stored. The
result is an array (variant type VT_ARRAY | VT_VARIANT)
containing one value for each column in the result. Call
GetColumnCount() to determine the number of values in the
array.

Each value is specified in either its native data type or the
closest variant data type. The supported return types are:
string (variant type VT_BSTR), float (variant type VT_R4),
double (variant type VT_R8), short (variant type VT_I2), long
(variant type VT_I4), and binary (variant type VT_UI1 |
VT_ARRAY).

When the end of the result set has been reached (there are no
more rows to fetch) or if the result set is empty, the result is
empty (variant type VT_EMPTY) instead of an array .

You must properly initialize the VARIANT before calling this
function. Visual Basic does this automatically. Visual C++
programmers must call VariantInit().

Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.
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Return Value
Zero if successful, nonzero if unsuccessful. When the end of the result set is
reached, the return value is -1. If the return value is nonzero, you can call
GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
FetchNextRows()

FetchNextRowEx()
short FetchNextRowEx(long QueryID)

Description
This function fetches the next row of data from the database. You can use this
function in environments that do not support VARIANT arrays, such as
Microsoft Access 2.0. Use this function in conjunction with GetColumnValue()
to retrieve the data in each column for the current row.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Return Value
Zero if successful, nonzero if unsuccessful. When the end of the result set is
reached, the return value is -1. If the return value is nonzero, you can call
GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
FetchNextRowsEx()

FetchNextRows()
short FetchNextRows(long QueryID, VARIANT* Rows, long* NumRows)

Description
This function fetches the next NumRows of data from the database.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().
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Row A pointer to a VARIANT in which the result is stored. The
result is a two dimensional array (variant type VT_ARRAY |
VT_VARIANT) containing one value for each column in each
row. Call GetColumnCount() to determine the number of
columns in the array. The dimensions of the array are
[NumRows][ColumnCount], even if the number of unfetched
rows in the result set is less than NumRows (in this case, the
array contains extra, unused entries).

Each value is specified in either its native data type or the
closest variant data type. The supported return types are:
string (variant type VT_BSTR), float (variant type VT_R4),
double (variant type VT_R8), short (variant type VT_I2), long
(variant type VT_I4), and binary (variant type VT_UI1 |
VT_ARRAY).

When the end of the result set has been reached (there are no
more rows to fetch) or if the result set is empty, the result is
empty (variant type VT_EMPTY) instead of an array

You must properly initialize the VARIANT before calling this
function. Visual Basic does this automatically. Visual C++
programmers must call VariantInit().

NumRows A pointer to a long containing the number of row to fetch. If
the number of unfetched rows in the result set is less than
NumRows, NumRows is reset to the actual number of rows
contained in the result.

Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.

Return Value
Zero if successful, nonzero if unsuccessful. When the end of the result set is
reached, the return value is -1. If the return value is nonzero, you can call
GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
FetchNextRow()

FetchNextRowsEx()
short FetchNextRowsEx(long QueryID, long* NumRows)
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Description
This function fetches the next NumRows of data from the database. You can
use this function in environments that do not support VARIANT arrays, such
as Microsoft Access 2.0. Use this function in conjunction with
GetColumnValueEx() to retrieve the data in each column for a given row.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

NumRows A pointer to a long containing the number of row to fetch. If
the number of unfetched rows in the result set is less than
NumRows, NumRows is reset to the actual number of rows
contained in the result.

Return Value
Zero if successful, nonzero if unsuccessful. When the end of the result set is
reached, the return value is -1. If the return value is nonzero, you can call
GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
FetchNextRowEx()

FlushQMFCache()
void FlushQMFCache()

Description
This function tells QMF for Windows to flush its cache of QMF information,
discarding its contents. The next time QMF for Windows needs QMF
information, it obtains it from the database. Normally, QMF for Windows
caches QMF information obtained from the database to reduce database traffic
and improve performance. You call this function prior to calling
GetQMFObjectInfo(), GetQMFQueryText(), or GetQMFObjectList() to ensure
that the information returned is up to date.

Return Value
None.

GetColumnCount()
long GetColumnCount(long QueryID)

Description
This function returns the number of columns in the result set.
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Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Return Value
The number of columns in each row if successful. If unsuccessful, 0 or -1. If
the return value is 0 or -1, you can call GetLastErrorString() or
GetLastErrorType(), GetLastSQLCode(), GetLastSQLError(), or
GetLastSQLState() to get additional error information.

GetColumnDataValue()
short GetColumnDataValue(long QueryID, long Index)

Description
This function returns the data value for the column specified in Index for the
current row of data. After calling this function, the Value property can be
interrogated for the returned value. You use this function with
FetchNextRowEx() to access the data in a single row of data.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Index The zero based index of the row of data to be retrieved.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

GetColumnHeader()
BSTR GetColumnHeader(long QueryID, long Index, short* Result)

Description
This function returns the column header (column name) associated with the
index Index.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Index The zero based index of the row of data to be retrieved.
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Result Zero if successful, nonzero if unsuccessful. If Result is nonzero,
you can call GetLastErrorString() or GetLastErrorType(),
GetLastSQLCode(), GetLastSQLError(), or GetLastSQLState() to
get additional error information.

Note: Column headings are not available for static SQL statements. For query
IDs returned from InitializeStaticQuery(), GetColumnHeader returns a
string of the form ″Coln″ where ″n″ is the column number.

Return Value
The string returned represents the column name as specified in the Index
parameter.

GetColumnHeaderEx()
short GetColumnHeaderEx(long QueryID, long Index)

Description
This function returns the column header (column name) associated with the
index Index. After calling this function, the Value property can be interrogated
for the returned value.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Index The zero based index of the row of data to be retrieved.

Note: Column headings are not available for static SQL statements. For query
IDs returned from InitializeStaticQuery(), GetColumnHeader returns a
string of the form ″Coln″ where ″n″ is the column number.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is zero, query
the Value property for the string representing the column name. If the return
value is nonzero, you can call GetLastErrorString() or GetLastErrorType(),
GetLastSQLCode(), GetLastSQLError(), or GetLastSQLState() to get additional
error information.

GetColumnHeadings()
short GetColumnHeadings(long QueryID, VARIANT* Headings)

Description
This function returns the column headings (also referred to as column names).
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Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Headings A pointer to a VARIANT in which the result is stored. The
result is an array of strings (variant type VT_ARRAY |
VT_BSTR) containing one string for each column heading.

You must properly initialize the VARIANT before calling this
function. Visual Basic does this automatically. Visual C++
programmers must call VariantInit().

Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.

Note: Column headings are not available for static SQL statements. For query
IDs returned from InitializeStaticQuery(), GetColumnHeadings returns
the strings ″Col1″, ″Col2″, etc.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

GetColumnValue()
short GetColumnValue(long QueryID, long Index, VARIANT* Value)

Description
This function returns the data value for the column specified in Index for the
current row of data. You use this function with FetchNextRowEx() to access
the data in a single row of data.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Index The zero based index of the row of data to be retrieved.
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Value A pointer to a VARIANT in which you want to store the
results. The result is a data value based on the variant type.

You must properly initialize the VARIANT before calling this
function. Visual Basic does this automatically. Visual C++
programmers must call VariantInit().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

GetColumnValueEx()
short GetColumnValueEx(long QueryID, long RowIndex, long ColIndex,
VARIANT* Value)

Description
This function returns the data value for the column specified in ColIndex for
the row of data specified in RowIndex. You use this function with
FetchNextRowsEx() to access the data in a single row of data.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

RowIndex The zero based index of the row to be retrieved.

ColIndex The zero based index of the column to be retrieved.

Value A pointer to a VARIANT in which you want to store the result.
You can query the resulting variant to find out the data type
for further processing.

You must properly initialize the VARIANT before calling this
function. Visual Basic does this automatically. Visual C++
programmers must call VariantInit().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

GetDefaultServerName()
BSTR GetDefaultServerName()

Description
This function returns a string containing the default server name.
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Return Value
A string that specifies the default server name.

GetGlobalVariable()
BSTR GetGlobalVariable(BSTR Name)

Description
This function retrieves the value of the specified global variable.

Parameters

Name Description

Name A string that contains the name of the variable you want to set.

Return Value
A string containing the global variable value, or NULL if the variable has no
value or an error occurs.

GetHostVariableNames()
short GetHostVariableNames(long QueryID, VARIANT* Names)

Description
This function returns an array of the names of all host variables referenced in
the specified query. The query must be a static query referencing host
variables (either stored with the QMF query or created by AddHostVariable()).

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Names A pointer to a VARIANT in which you want to store the result
array.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() to get additional error information.

GetHostVariableTypes()
short GetHostVariableTypes(long QueryID, VARIANT* Types)

Description
This function returns an array of the data types of all host variables
referenced in the specified query. The query must be a static query referencing
host variables (either stored with the QMF query or created by
AddHostVarialble()) See AddHostVariable() for a list of the data types that can
be returned.
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Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Types A pointer to a VARIANT in which you want to store the result
array.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() to get additional error information.

GetLastErrorString()
BSTR GetLastErrorString()

Description
This function returns a string containing information about the most recent
error. If you call this function after a function that executed successfully (with
no errors), then this function returns information about the last error that
occurred during a prior function call. To avoid confusion, always call this
function immediately after calling a function that returned an error.

Return Value
A string containing error information. If no errors occurred since you created
the QMF API object, NULL is returned.

Related Topics
GetLastErrorType()
GetLastSQLCode()
GetLastSQLError()
GetLastSQLState()

GetLastErrorType()
short GetLastErrorType()

Description
This function returns the type of the most recent error. If you call this function
after a function that executed successfully (with no errors), then this function
returns information about the last error that occurred during a prior function
call. To avoid confusion, always call this function immediately after calling a
function that returned an error.

Return Value
The returned value indicates the type of error:

Value Meaning
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0 (RS_ERROR_NONE) No errors have occurred since the QMF for
Windows API object was created.

1 (RS_ERROR_SQL) An SQL error occurred. If the error occurred
during a call to a function that takes QueryID as
an argument, call Close() to close that query. No
rollback is performed. You can continue to use
the QMF for Windows API object, although you
may encounter additional errors.

2 (RS_ERROR_USER_CANCEL) A user cancelled the operation, usually by
clicking Cancel on the busy window. This causes
QMF for Windows to perform an implicit
rollback (invalidating all outstanding query IDs)
and destroy the connection to the database. You
must call InitializeServer() or ReinitializeServer()
if you want to continue.

3 (RS_ERROR_FATAL_GOV) A fatal governor error occurred. One possibility is
that the QMF for Windows API timed out
because the maximum allowable idle time was
exceeded. This causes QMF for Windows to
perform an implicit rollback (invalidating all
outstanding query IDs) and destroy the
connection to the database. You must call
InitializeServer() or ReinitializeServer() if you
want to continue.

4 (RS_ERROR_NONFATAL_GOV) A non-fatal governor error occurred. Either the
maximum allowable number of rows to fetch was
exceeded, or the SQL verb is not allowed. If the
error occurred during a call to a function that
takes QueryID as an argument, call Close() to
close that query. No rollback is performed and
the connection to the database is unaffected, so
you may continue to use the QMF for Windows
API object.

5 (RS_ERROR_OTHER) A general error occurred. No rollback is
performed. You can continue to use the QMF for
Windows API object, although you may
encounter additional errors.

Related Topics
GetLastErrorString()
GetLastSQLCode()
GetLastSQLError()
GetLastSQLState()

GetLastSQLCode()
long GetLastSQLCode()

94 QMF: Getting Started with QMF for Windows



Description
This function returns the SQL code for the most recent error. If you call this
function after a function that executed successfully (with no errors), then this
function returns information about the last error that occurred during a prior
function call. To avoid confusion, always call this function immediately after
calling a function that returned an error.

Return Value
The SQL codes for the most recent error. If no errors occurred since you
created the QMF for Windows API object, or the most recent error was not an
SQL error, zero is returned.

Related Topics
GetLastErrorString()
GetLastErrorType()
GetLastSQLError()
GetLastSQLState()

GetLastSQLError()
VARIANT GetLastSQLError()

Description
This function returns detailed SQL error information for the most recent error.
If you call this function after a function that executed successfully (with no
errors), then this function returns information about the last error that
occurred during a prior function call. To avoid confusion, always call this
function immediately after calling a function that returned an error.

Return Value
An array (variant type VT_ARRAY | VT_VARIANT) containing error
information. If no errors occurred since you created the QMF for Windows
API object, or the most recent error was not an SQL error, empty (variant type
VT_EMPTY) is returned. The array has the following format:

Element Type Contents

0 long (VT_I4) Code

1 string (VT_BSTR) State

2 string (VT_BSTR) ErrProc

3 string (VT_BSTR) RDBName

4 long (VT_I4) ErrD1

5 long (VT_I4) ErrD2

6 long (VT_I4) ErrD3

7 long (VT_I4) ErrD4

8 long (VT_I4) ErrD5
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9 long (VT_I4) ErrD6

10 string (VT_BSTR) Warn0

11 string (VT_BSTR) Warn1

12 string (VT_BSTR) Warn2

13 string (VT_BSTR) Warn3

14 string (VT_BSTR) Warn4

15 string (VT_BSTR) Warn5

16 string (VT_BSTR) Warn6

17 string (VT_BSTR) Warn7

18 string (VT_BSTR) Warn8

19 string (VT_BSTR) Warn9

20 string (VT_BSTR) WarnA

21 string (VT_BSTR) MessageTokens

Related Topics
GetLastErrorString()
GetLastErrorType()
GetLastSQLCode()
GetLastSQLState()

GetLastSQLState()
BSTR GetLastSQLState()

Description
This function returns the SQL state for the most recent error. If you call this
function after a function that executed successfully (with no errors), then this
function returns information about the last error that occurred during a prior
function call. To avoid confusion, always call this function immediately after
calling a function that returned an error.

Return Value
A string containing the SQL code for the most recent error. If no errors
occurred since you created the QMF for Windows API object, or the most
recent error was not an SQL error, NULL is returned.

Related Topics
GetLastErrorString()
GetLastErrorType()
GetLastSQLCode()
GetLastSQLError()
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GetOption()
short GetOption(short Option, VARIANT* Value)

Description
Gets the specified option value in QMF for Windows.

Parameters

Name Description

Option Specifies which option to retrieve.

Value Meaning

0 (RSO_SERVER_DEFINITION_FILE) Server definition file name.

1 (RSO_CPIC_DLL) CPI-C provider DLL file name.

2 (RSO_CPIC_TIMEOUT_WARNING) CPI-C warning timeout (in seconds). This limit
is not used by the QMF for Windows API.

3 (RSO_CPIC_TIMEOUT_CANCEL) CPI-C cancel timeout (in seconds).

4 (RSO_TCP_TIMEOUT_WARNING) TCP warning timeout (in seconds). This limit
is not used by the QMF for Windows API.

5 (RSO_TCP_TIMEOUT_CANCEL) TCP cancel timeout (in seconds).

6 (RSO_DISPLAY_NULLS_STRING) The string to use to display null values.

7 (RSO_ENTER_NULLS_STRING) The string to use to enter null values.

8 (RSO_ENTER_DEFAULTS_STRING) The string to use to enter default values.

9 (RSO_TRACE_FILE_1) Trace file 1 name.

10 (RSO_TRACE_FILE_2) Trace file 2 name.

11 (RSO_TCP_TRACE_LEVEL) TCP trace level.

12 (RSO_CPIC_TRACE_LEVEL) CPI-C trace level.

13 (RSO_DDM_TRACE_LEVEL) DDM trace level.

Value A pointer to a VARIANT in which the result is stored. The
result is an array (variant type VT_ARRAY | VT_VARIANT)
containing one value for each column in the result. Call
GetColumnCount() to determine the number of values in the
array. You must properly initialize the VARIANT before calling
this function. Visual Basic does this automatically. Visual C++
programmers must call VariantInit().

Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
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Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.

Return Value
Zero if successful, nonzero is unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

Related Topics
SetOption()

GetOptionEx()
short GetOptionEx(short Option)

Description
Gets the specified option value in QMF for Windows. When the option value
is returned, you must query the Option property for the data.

Parameters

Name Description

Option The option values are the same as those for the GetOption()
call.

Return Value
Zero if successful, nonzero is unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

Related Topics
GetOption()
SetOption()

GetProcText()
BSTR GetProcText(long ProcID)

Description
This function returns the text that is executed for the specified procedure,
after variable substitution. You should use SetProcVariable() to set the value of
any variables use in the procedure before calling this function.

Parameters

Name Description
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ProcID The ID of the procedure as returned from InitializeProc().

Return Value
If successful, a string containing the procedure text is returned. If
unsuccessful, NULL is returned. If the return value is NULL, you can call
GetLastErrorString() or GetLastErrorType() to get additional error information.

GetProcVariables()
short GetProcVariables(long ProcID, VARIANT* Variables)

Description
Gets the specified option value in QMF for Windows.

Parameters

Name Description

ProcID The ID of the procedure as returned from InitializeProc().

Value A pointer to a VARIANT in which the result is stored. The
result is an array of strings (variant type VT_ARRAY |
VT_BSTR) with each string containing the name of one
variable. If there are no variables in the procedure, the result is
empty (variant type VT_EMPTY). You must properly initialize
the VARIANT before calling this function. Visual Basic does
this automatically. Visual C++ programmers must call
VariantInit().

Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.

Return Value
Zero if successful, nonzero is unsuccessful. If there are no variables in the
procedure, the return value is RS_NO_ERROR_NO_DATA (-1). If the return
value is nonzero, you can call GetLastErrorString() or GetLastErrorType() to
get additional error information.

GetQMFObjectInfo()
short GetQMFObjectInfo(BSTR OwnerAndName, short Type, short Time,
VARIANT* Value)
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Description
This function returns information about a QMF object (either a form or a
query). The information returned is specified by the Type and Time
parameters.

Parameters

Name Description

OwnerAndName A string containing the owner and name, separated by a
period, of the object for which you want to retrieve
information. For example,

John.Query2

Value A pointer to a VARIANT in which the result is stored. For
RSI_TIMEUSED, RSI_TIMESRUN, RSI_TIMESCANCELLED,
and RSI_LEVEL, the result is a short (variant type VT_I2). For
RSI_RESTRICTED the result is a Boolean (variant type
VT_BOOL). For all others, the result is a string (variant type
VT_BSTR). You must properly initialize the VARIANT before
calling this function. Visual Basic does this automatically.
Visual C++ programmers must call VariantInit().

Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.

Type Specifies the type of information to get.

Value Meaning

0 (RSI_COMMENT) Comment

1 (RSI_LEVEL) Level

2 (RSI_TYPE) Type

3 (RSI_SUBTYPE) Sub type

4 (RSI_RESTRICTED) Restricted

5 (RSI_MODEL) Model

6 (RSI_TIMESUSED) Number of times used.

7 (RSI_TIMESRUN) Number of times run.

8 (RSI_TIMESCANCELLED) Number of times cancelled.
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9 (RSI_DATE) Date first used, last used, or last modified.

10 (RSI_TIME) Time first used, last used, or last modified.

11 (RSI_USERID) User ID first used, last used, or last modified.

12 (RSI_SQLID) SQL ID first used, last used, or last modified.

13 (RSI_ENVIRONMENT) Environment first used, last used, or last
modified.

14 (RSI_MODE) Mode first used, last used, or last modified.

15 (RSI_COMMAND) Command first used, last used, or last
modified.

Time Specifies first used, last used, or last modified.

Value Meaning

0 (RST_FIRSTUSED) First used.

1 (RST_LASTUSED) Last used.

2 (RST_LASTMODIFIED) Last modified.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

GetQMFObjectInfoEx()
short GetQMFObjectInfoEx(BSTR OwnerAndName, short Type, short Time)

Description
This function returns information about a QMF object. The information
returned is specified by the Type and Time parameters. After calling this
function, the QMFObjectInfo property can be interrogated for the returned
value.

Parameters

Name Description

OwnerAndName A string containing the owner and name, separated by a
period, of the object for which you want to retrieve
information. For example,

John.Query2

Type Specifies the type of information to get.
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Value Meaning

0 (RSI_COMMENT) Comment

1 (RSI_LEVEL) Level

2 (RSI_TYPE) Type

3 (RSI_SUBTYPE) Sub type

4 (RSI_RESTRICTED) Restricted

5 (RSI_MODEL) Model

6 (RSI_TIMESUSED) Number of times used.

7 (RSI_TIMESRUN) Number of times run.

8 (RSI_TIMESCANCELLED) Number of times cancelled.

9 (RSI_DATE) Date first used, last used, or last modified.

10 (RSI_TIME) Time first used, last used, or last modified.

11 (RSI_USERID) User ID first used, last used, or last modified.

12 (RSI_SQLID) SQL ID first used, last used, or last modified.

13 (RSI_ENVIRONMENT) Environment first used, last used, or last
modified.

14 (RSI_MODE) Mode first used, last used, or last modified.

15 (RSI_COMMAND) Command first used, last used, or last
modified.

Time Specifies first used, last used, or last modified.

Value Meaning

0 (RST_FIRSTUSED) First used.

1 (RST_LASTUSED) Last used.

2 (RST_LASTMODIFIED) Last modified.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

GetQMFObjectList()
short GetQMFObjectList(BSTR Owner, BSTR Name, short Type, VARIANT* List)

Description
This function returns an array of the names of all QMF objects matching the
patterns specified in the Owner and Name parameters.
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Parameters

Name Description

Owner A string containing the owner of the objects you want to
include in the returned list.

Name A string containing the name of the objects you want to
include in the returned list.

List A pointer to a VARIANT in which the result is stored. The
result is an array of strings (variant type VT_ARRAY | VT
_BSTR), each of format Owner.Name. If no matching QMF for
Windows queries are found, the result is empty (variant type
VT_EMPTY). You must properly initialize the VARIANT before
calling this function. Visual Basic does this automatically.
Visual C++ programmers must call VariantInit().

Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.

Type Specifies the types of QMF objects that you want to include in
the list. These values can be added together to specify multiple
object types.

Value Meaning

2048 (RSQ_MASK_QUERIES) Include QMF queries in the list.

1024 (RSQ_MASK_FORMS) Include QMF forms in the list.

512 (RSQ_MASK_PROCS) Include QMF procedures in the list.

256 (RSQ_MASK_TABLES) Include tables in the list.

Return Value
Zero if successful, nonzero if unsuccessful. If no matching QMF objects are
found, the return value is zero. If the return value is nonzero, you can call
GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

GetQMFObjectListEx()
short GetQMFObjectListEx(BSTR Owner, BSTR Name, short Index)
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Description
This function returns the name of the QMF object matching the patterns
specified in the Owner and Name parameters referenced by the Index
parameter. After calling this function, the Value property can be interrogated
for the returned value.

Parameters

Name Description

Owner A string containing the owner of the objects you want to
include in the returned list.

Name A string containing the name of the objects you want to
include in the returned list.

Index The index of the list of QMF objects that match the pattern.

Type Specifies the types of QMF objects that you want to include in
the list. These values can be added together to specify multiple
object types.

Value Meaning

2048 (RSQ_MASK_QUERIES) Include QMF queries in the list.

1024 (RSQ_MASK_FORMS) Include QMF forms in the list.

512 (RSQ_MASK_PROCS) Include QMF procedures in the list.

256 (RSQ_MASK_TABLES) Include tables in the list.

Return Value
Zero if successful, nonzero if unsuccessful. If no matching QMF objects are
found, the return value is RS_ERROR_OUTOFRANGE. If the return value is
nonzero, you can call GetLastErrorString() or GetLastErrorType(),
GetLastSQLCode(), GetLastSQLError(), or GetLastSQLState() to get additional
error information.

GetQMFProcText()
BSTR GetQMFProcText(BSTR OwnerAndName)

Description
This function returns the text that is executed for the specified procedure,
after variable substitution. You should use SetProcVariable() to set the value of
any variables use in the procedure before calling this function.

Parameters

Name Description
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OwnerAndName A string containing the owner and name, separated by a
period, of the object that you want to delete. For example,

John.Proc2

Return Value
A string containing the text for the procedure that was retrieved, or NULL if
the procedure could not be retrieved. If the return value is NULL, you can
call GetLastErrorString(), GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError, or GetLastSQLState() to get additional error information.

GetQMFQueryText()
BSTR GetQMFQueryText(BSTR OwnerAndName)

Description
This function retrieves the SQL text stored in the specified query.

Parameters

Name Description

OwnerAndName A string containing the owner and name, separated by a
period, of the object that you want to delete. For example,

John.Query2

Return Value
A string containing the text for the query that was retrieved, or NULL if the
query could not be retrieved. If the return value is NULL, you can call
GetLastErrorString(), GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError, or GetLastSQLState() to get additional error information.

GetQueryText()
BSTR GetQueryText(long QueryID)

Description
This function returns the SQL text that is executed for the specified query,
after variable substitution. You should use SetVariable() to set the value of any
variables used in the query before calling this function.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().
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Note: The query text is not available for static SQL statements. For query IDs
returned from InitializeStaticQuery(), GetQueryText() returns an empty
string.

Return Value
If successful, a string containing the SQL text is returned. If unsuccessful,
NULL is returned. If the return value is NULL, you can call
GetLastErrorString() or GetLastErrorType() to get additional error information.

GetQueryVerb()
BSTR GetQueryVerb(long QueryID)

Description
This function returns a string containing the SQL verb you used in the query.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Note: The query verb is not available for static SQL statements. For query IDs
returned from InitializeStaticQuery(), GetQueryVerb() returns an empty
string.

Return Value
If successful, a string containing the SQL verb is returned. If unsuccessful,
NULL is returned. If the return value is NULL, you can call
GetLastErrorString() or GetLastErrorType() to get additional error information.

GetResourceLimit()
short GetResourceLimit(short Resource, long* Value)

Description
This function gets the requested resource limit. You must call InitializeServer()
prior to calling this function, since resource limits are handled on a per-server
basis.

Parameters

Name Description

Resource The resource values include:

Value Meaning

0 (RSR_IDLE_CONNECTION_TIMEOUT) Idle connection timeout (in
seconds).

106 QMF: Getting Started with QMF for Windows



1 (RSR_IDLE_QUERY_TIMEOUT_CANCEL) Idle query timeout (in
seconds).

2 (RSR_IDLE_QUERY_TIMEOUT_WARNING) Idle query timeout (in
seconds). This is the
warning limit; it is not
enforced for the QMF for
Windows API.

3 (RSR_SERVER_RESPONSE_TIMEOUT_CANCEL) Server timeout (in
seconds).

4 (RSR_SERVER_RESPONSE_TIMEOUT_WARNING) Server timeout (in
seconds). This is the
warning limit; it is not
enforced for the QMF for
Windows API.

5 (RSR_MAX_ROWS_TO_FETCH_CANCEL) Maximum number of rows
to fetch.

6 (RSR_MAX_ROWS_TO_FETCH_WARNING) Maximum number of rows
to fetch. This is the
warning limit; it is not
enforced for the QMF for
Windows API.

7 (RSR_MAX_BYTES_TO_FETCH_CANCEL) Maximum number of bytes
to fetch.

8 (RSR_MAX_BYTES_TO_FETCH_WARNING) Maximum number of bytes
to fetch. This is the
warning limit; it is not
enforced for the QMF for
Windows API.

9 (RSR_MAX_CONNECTIONS) Maximum number of
connections allowed to the
database server.

10 (RSR_ALLOW_SERVER_ACCESS_UI) Is access allowed to the
database server from the
QMF for Windows
interface?

11 (RSR_ALLOW_SERVER_ACCESS_API) Is access allowed to the
database server from the
QMF for Windows API?

12 (RSR_FETCH_ALL_ROWS) Automatically fetch all
rows?
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13 (RSR_CONFIRM_UPDATES) Confirm database server
updates? This option has
no effect on the QMF for
Windows API; database
updates are not confirmed
for the QMF for Windows
API.

14 (RSR_SUMMARY_TRACKING) Is summary object tracking
enabled?

15 (RSR_DETAILED_TRACKING) Is detailed object tracking
enabled?

16 (RSR_SQL_TRACKING) Is SQL text tracking
enabled?

17 (RSR_ADHOC_TRACKING) Is ad hoc object tracking
enabled?

18 (RSR_ALLOW_ACQUIRE) Is the SQL verb ACQUIRE
allowed?

19 (RSR_ALLOW_ALTER) Is the SQL verb ALTER
allowed?

20 (RSR_ALLOW_COMMENT) Is the SQL verb
COMMENT allowed?

21 (RSR_ALLOW_CREATE) Is the SQL verb CREATE
allowed?

22 (RSR_ALLOW_DELETE) Is the SQL verb DELETE
allowed?

23 (RSR_ALLOW_DROP) Is the SQL verb DROP
allowed?

24 (RSR_ALLOW_EXPLAIN) Is the SQL verb EXPLAIN
allowed?

25 (RSR_ALLOW_GRANT) Is the SQL verb GRANT
allowed?

26 (RSR_ALLOW_INSERT) Is the SQL verb INSERT
allowed?

27 (RSR_ALLOW_LABEL) Is the SQL verb LABEL
allowed?

28 (RSR_ALLOW_LOCK) Is the SQL verb LOCK
allowed?

29 (RSR_ALLOW_REVOKE) Is the SQL verb REVOKE
allowed?

30 (RSR_ALLOW_SELECT) Is the SQL verb SELECT
allowed?
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31 (RSR_ALLOW_SET) Is the SQL verb SET
allowed?

32 (RSR_ALLOW_SIGNAL) Is the SQL verb SIGNAL
allowed?

33 (RSR_ALLOW_UPDATE) Is the SQL verb UPDATE
allowed?

34 (RSR_ALLOW_CALL) Is the SQL verb CALL
allowed?

35 (RSR_ALLOW_SAVE_DATA) Is the Save Data command
allowed?

36 (RSR_SAVE_DATA_TABLE_SPACE_NAME) The default collection
name for binding
packages?

37
(RSR_SAVE_DATA_TABLE_SPACE_NAME_OVERRIDE)

Can the default table space
name for the Save Data
command be overridden
by the user?

38 (RSR_ALLOW_BIND_PACKAGE) Allow binding of
packages?

39 (RSR_DEF_COLLECTION) The default collection
name for binding
packages.

40 (RSR_DEF_COLLECTION_OVERRIDE) Can the default collection
name for binding packages
be overridden by the user?

41 (RSR_DEF_ISOLATION_LEVEL) The default isolation level
for binding packages.

42 (RSR_DEF_ISOLATION_LEVEL_OVERRIDE) Can the default isolation
level for binding packages
be overridden by the user.

43 (RSR_ALLOW_TABLE_EDIT) Allow use of the table
editor?

44 (RSR_ALLOW_EXPORT) Allow exporting of data?

45 (RSR_ALLOW_SAVED_QUERIES_ONLY) Is the user allowed to run
only saved queries?

46 (RSR_ALLOW_DROP_PACKAGE) Allow dropping of
packages?

47 (RSR_QUERY_ISOLATION_LEVEL) The isolation level to use
when running queries.
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48 (RSR_ACCOUNT_STRING) The string specifying
account information to
pass when connecting to
the database server.

49 (RSR_ACCOUNT_OVERRIDE) Can the string specifying
account information to
pass when connecting to
the database server be
overridden by the user?

Value A pointer to a long in which the result is stored. The result is
the value of the requested resource limit. For Boolean values,
the result is non-zero for true, zero for false. For
RSR_SAVE_DATA_TABLE_SPACE_NAME,
RSR_DEF_COLLECTION, and RSR_ACCOUNT_STRING, -1 is
returned and the ResourceLimit property can be interrogated for
the returned string value.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

GetResourceLimitEx()
short GetResourceLimitEx(short Resource)

Description
This function gets the requested resource limit. You must call InitializeServer()
prior to calling this function, since resource limits are handled on a per-server
basis. After a call to this function, query the ResourceLimit property for the
result.

Parameters

Name Description

Resource The resource values are the same as those for the
GetResourceLimit() call.

Note: The query verb is not available for static SQL statements. For query IDs
returned from InitializeStaticQuery(), GetQueryVerb() returns an empty
string.
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Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

GetRowCount()
long GetRowCount(long QueryID)

Description
This function returns the number of rows currently in QMF for Windows’
internal buffer. This may be greater than the number of rows retrieved with
FetchNextRow() or FetchNextRows(), since QMF for Windows buffers data
received from the database.

This function returns the number of rows already retrieved from the database.
If you want to retrieve the total number of rows in the result set, you can:
v Call CompleteQuery() and fetch all the rows using FetchNextRow() or

FetchNextRows().
v Specify FetchAllRows = TRUE when you call Open().

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Return Value
The number of rows if successful (0 if no rows have been retrieved), or -1 if
unsuccessful. If 1, you can call GetLastErrorString() or GetLastErrorType() to
get additional error information.

GetServerList()
short GetServerList(VARIANT* List)

Description
This function returns an array containing the names of the database servers
defined in QMF for Windows’ Server Definition File (SDF). You must define a
database server in the SDF file if you want to access it using the QMF for
Windows API.

Parameters

Name Description

Chapter 13. Using the QMF for Windows API 111



List A pointer to a VARIANT in which the result is stored. The
result is an array of strings (variant type VT_ARRAY | VT
_BSTR), with each string containing the name of one database
server. If you have not defined any database servers, the result
is empty (variant type VT_EMPTY). You must properly
initialize the VARIANT before calling this function. Visual
Basic does this automatically. Visual C++ programmers must
call VariantInit().

Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.

Return Value
Zero if successful, nonzero if unsuccessful. If you have not defined any
database servers, the return value is zero. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

GetServerListEx()
short GetServerListEx(short Index)

Description
This function retrieves the name of the server referenced by the Index
parameter. After calling this function, the Value property can be interrogated
for the returned value.

Parameters

Name Description

Index An index into the list of servers.

Return Value
Zero if successful, RS_OUTOFRANGE when the index is greater than the
number of servers available, nonzero if unsuccessful. If you have not defined
any database servers, the return value is RS_OUTOFRANGE. If the return
value is nonzero, you can call GetLastErrorString() or GetLastErrorType() to
get additional error information.

GetStoredProcedureResultSets()
short GetStoredProcedureResultSets(long QueryID, VARIANT* ResultSets)
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Description
This function retrieves the query IDs for the result sets returned by the stored
procedure executed with the original QueryID. Each query ID returned can be
used with FetchNextRow() or FetchNextRows() to retrieve the result set rows,
and Close() when the end of each result set is reached.

Parameters

Name Description

QueryID The ID of the original query as returned from InitializeQuery().

ResultSets A pointer to a VARIANT in which the query IDs for the result
sets are stored. The result is an array of long integers (variant
type VT_ARRAY | VT _I4), with each integer being the query
ID for the corresponding result sets. If the stored procedure did
not return any result sets, the result is empty (variant type
VT_EMPTY). You must properly initialize the VARIANT before
calling this function. Visual Basic does this automatically.
Visual C++ programmers must call VariantInit().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

GetVariables()
short GetVariables(long QueryID, VARIANT* Variables)

Description
This function returns an array of the names of the variables in the SQL text of
the query. You must assign values to these variables by calling SetVariable()
prior to running the query using either Open() or Execute().

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Variables A pointer to a VARIANT in which the result is stored. The
result is an array of strings (variant type VT_ARRAY | VT
_BSTR), with each string containing the name of one variable.
If there are no variables in the SQL statement, the result is
empty (variant type VT_EMPTY). You must properly initialize
the VARIANT before calling this function. Visual Basic does
this automatically. Visual C++ programmers must call
VariantInit().
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Note: Due to a bug in Microsoft Excel 7.0 and Microsoft Access 7.0 (and
possibly other 32-bit Microsoft products that use Visual Basic for
Applications), string data in Variant variables received from QMF for
Windows may not be translated from Unicode (used by OLE) to ANSI
(used by VBA). When this occurs, only the first character of the string
is displayed. To remedy this problem, set the variable equal to an
empty string before you call the QMF for Windows function that uses
the variable.

Return Value
Zero if successful, nonzero if unsuccessful. If there are no variables in the SQL
statement, the return value is RS_ERROR_NO_DATA (-1). If the return value
is nonzero, you can call GetLastErrorString() or GetLastErrorType() to get
additional error information.

GetVariablesEx()
short GetVariablesEx(long QueryID, short Index)

Description
This function returns the name of the variable in the SQL text of the query
referenced by the Index parameter. After calling this function, the Value
property can be interrogated for the returned value. You must assign values to
this variable (and all others in the SQL text) by calling SetVariable() prior to
running the query using either Open() or Execute().

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Variables An index into the internal list of variables. Query the Value
property for the string that corresponds with the index passed
in. If there are no variables in the SQL statement, the function
returns RS_ERROR_NO_DATA.

Return Value
Zero if successful, nonzero if unsuccessful. If there are no variables in the SQL
statement, the return value is RS_ERROR_NO_DATA (-1). If the return value
is nonzero, you can call GetLastErrorString() or GetLastErrorType() to get
additional error information.

InitializeProc()
long InitializeProc(short SourceType, BSTR Source)

114 QMF: Getting Started with QMF for Windows



Description
This function sets the text that you want to use in a procedure. You can pass
the text as a parameter to this function, read it from a text file, or obtain it
from an existing procedure.

Parameters

Name Description

SourceType Specifies the source for the procedure text.

Value Meaning

0 (RSS_STRING) The text is contained in the Source parameter.

2 (RSS_FILE) The text is contained in the text file whose
name is specified by the Source parameter.

3 (RSS_QMFPROC) The text is contained in the procedure whose
owner and name are specified by the Source
parameter.

Source A string containing the text, the owner and name
(Owner.Name) of the procedure, or the name of a file
containing the procedure text.

Return Value
If successful, the ID of the procedure (ProcID). If unsuccessful, -1. You must
use this value in all interface calls that require the ProcID parameter.

InitializeQuery()
long InitializeQuery(short SourceType, BSTR Source)

Description
This function sets the text that you want to use in a query. You can pass the
SQL text as a parameter to this function, read it from a text file, or obtain it
from an existing query. Call close() when you are finished with the query.

Parameters

Name Description

SourceType Specifies the source for the SQL statement text.

Value Meaning

0 (RSS_STRING) The SQL text is contained in the Source
parameter.
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1 (RSS_QMFQUERY) The SQL text is contained in the query whose
owner and name are specified by the Source
parameter.

2 (RSS_FILE) The SQL text is contained in the text file
whose name is specified by the Source
parameter.

Return Value
If successful, the ID of the query. If unsuccessful, -1. You must use this value
in all interface calls that require the Query parameter.

InitializeServer()
short InitializeServer(BSTR ServerName, BSTR UserID, BSTR Password, BOOL
ForceDialog, [VARIANT Account], [VARIANT SuppressDialog])

Description
This function initializes a connection to a database server. You must call this
function prior to calling any other function in the QMF for Windows API. You
can call this function multiple times. However, if you call this function and do
not end by calling Commit() or Rollback() an implicit rollback results.

Parameters

Name Description

ServerName A string containing the name of the database server that you
want to use. This name must match one of the names defined
in the QMF for Windows Server Definition File. Call
GetServerList() to retrieve a list of valid servers.

UserID A string containing the User ID you want to use. If UserID is
NULL or an empty string, QMF for Windows attempts to use
the User ID from the most recent query, if available. Otherwise,
QMF for Windows displays the User Information dialog box to
obtain a User ID and password.

Password A string containing the password for the specified user ID. If a
Password is NULL or an empty string, QMF for Windows
attempts to use a memorized password if available (requires
Windows for Workgroups). If no password is available, QMF
for Windows displays the User Information dialog box to
obtain a password.

ForceDialog Nonzero indicates that QMF for Windows displays the User
Information dialog box regardless of whether a User ID and
Password are specified. This gives the user a chance to change
the information before it is used. Zero indicates that QMF for
Windows should display the User Information dialog box only
when necessary.
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Account Optionally, a string specifying accounting information to pass
to the server when connecting. The server may use this
information in a job accounting system.

SuppressDialog Nonzero indicates that QMF for Windows does not display the
User Information dialog box, even if a user ID and password
have not been specified. This option is useful when executing
in an environment where no user is present to respond to the
User Information dialog box, for example on a web server.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
SetParent()

InitializeStaticQuery()
long InitializeStaticQuery(BSTR CollectionName, BSTR PackageName, BSTR
ConsistencyToken, short SectionNumber)

Description
This function specifies the section of a package that you want to run as a
static query.

Parameters

Name Description

CollectionName The name of a previously bound collection.

PackageName The name of a previously bound package.

ConsistencyToken The token used by the above named collection and package.

SectionNumber The section number of the statement within the collection and
package you want to run.

Return Value
If successful, the ID of the query. If unsuccessful, -1. You must use this value
in all interface calls that require the QueryID parameter.

IsStatic()
BOOL IsStatic(long QueryID)

Description
This function determines whether or not the specified query ID refers to a
static query or a dynamic query.
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Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery() or
InitializeStaticQuery().

Return Value
Returns nonzero if successful and QueryID refers to a static query, zero
otherwise.

Open()
short Open(long QueryID, long RowLimit, BOOL FetchAllRows)

Description
Use this function to run a query that uses the SELECT verb, by opening a
cursor in the database for the query. Use FetchNextRow() or FetchNextRows()
to retrieve the data for the query, and call Close() when you are done. If QMF
for Windows is configured to automatically fetch all rows (see
RSR_FETCHALLROWS in the description for GetResourceLimit()) or the
FetchAllRows parameter is nonzero, QMF for Windows fetches all rows of the
result set into its internal buffer before returning from this call.

Note: The name of this function conflicts with the Microsoft Access 2.0
keyword Open. If you are using MS Access 2.0, place square brackets [
] around the function name.

Note: Use this function only in statements that contain the SQL verb SELECT.
For statements containing any other verb, for example, SET, call
Execute() instead. To determine the verb used by a query, call
GetQueryVerb().

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

RowLimit A number indicating the maximum number of rows to retrieve
from the database. Zero indicates that no limit is enforced
except for the row limit established by the QMF for Windows
Administrator program.

FetchAllRows A Boolean value that indicates whether or not all rows in the
result set are automatically fetched into the QMF for Windows
internal buffer. If nonzero, all rows are automatically fetched,
closing the cursor and freeing the database for use by other
users. This is the same as calling CompleteQuery().
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Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Prepare()
short Prepare(long QueryID)

Description
This function prepares the query specified by QueryID. The statement is
examined by the database server, checking for object existence, required
authorizations, etc. If the query is a SELECT statement, information about the
columns returned by the statement is available after completing Prepare().

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
Execute()
Open()

PrintReport()
short PrintReport(long QueryID, short SourceType, BSTR Source, BSTR
OutputFileName, short PageLength, short PageWidth, BOOL IncludeDateTime,
BOOL IncludePageNumbers, [VARIANT Format], [VARIANT UseFormPageSetup])

Description
PrintReport() is a synonym for the ExportReport().

ReinitializeServer()
short ReinitializeServer()

Description
This function reinitializes the connection to a database server. Normally, you
only need to call this function if one of the other QMF for Windows API
functions returns an error. Calling this function results in an implicit rollback,
which closes any open cursors and invalidates all outstanding query IDs.
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Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Rollback()
short Rollback()

Description
This function cancels any changes made in the current unit of work, ends the
current unit of work, closes any open cursors, and invalidates all outstanding
query IDs.

Note: The name of this function conflicts with the Microsoft Access 2.0
keyword Rollback. If you are using MS Access 2.0, place square
brackets [ ] around the function name.

Note: The rollback only affects SQL changes that were run by calling Open()
or Execute(). Rollback does not affect changes made by other QMF for
Windows API functions, such as FastSaveData(), SaveData(), or
DeleteQMFObject().

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

Related Topics
Commit()

RunProc()
short RunProc(long ProcID)

Description
This function runs the specified procedure. The procedure runs to completion
or until an error occurs. You cannot access any of the results of the procedure
(for example, data from a query that was run) through this programming
interface. However, any files exported or data saved by the procedure are
available after the run.

Parameters

Name Description

ProcID The ID of the procedure as returned from InitializeProc().
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Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

SaveData()
short SaveData(long QueryID, long FirstRow, long FirstCol, long LastRow, long
LastCol, BOOL Replace, BSTR TableName, BSTR TableSpaceName, BSTR
ServerName, BSTR UserID, BSTR Password, BOOL ForceDialog, [VARIANT
Account], [VARIANT Comment], [VARIANT CommitScope])

Description
This function saves the specified range of rows and columns into the specified
table in the specified table space. You must call CompleteQuery() prior to
calling this function if you have not retrieved row data for all of the rows you
want to save in the table. If you try to save rows that have not been retrieved
from the database, the save fails. If the table already exists, the new data must
have the same number and types of columns as the existing table.

This function operates in a separate unit of work than other API functions
and its results are automatically committed. Calling Commit() or Rollback()
has no effect on changes you make using this function.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

FirstRow The first row that you want to include in the save. The value of
the first row in a result set is 0.

FirstCol The first column that you want to include in the save. The
value of the first column in a result set is zero.

LastRow The last row that you want to include in the save, or -1 if all
rows are included. The value of the last row in a result set is
one less than the total number of rows.

LastCol The last column that you want to include in the save, or -1 if all
columns are included. The value of the last column in a result
set is one less than the total number of columns.

Replace Nonzero indicates that the specified data replaces any existing
data in the table. Zero indicates that the specified data is
appended to any existing data in the table.

TableName The name of the table in which the data is stored. If the table
doesn’t exist, it is created.
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TableSpaceName The name of the table space in which the table exists or is
created. If TableSpaceName is NULL or an empty string, the
default table space is used. If you have configured QMF for
Windows to always use the default table space (see
RSR_SDDIFFERENTTS in the description for
GetResourceLimit()), this parameter is ignored.

ServerName The name of the database server in which the table is stored. If
ServerName is NULL or an empty string, the server you specify
in the call to InitializeServer() is used, and UserID, Password,
ForceDialog, and Account are ignored.

UserID If you specified a different server in ServerName, UserID is the
user ID used for that server. If you do not specify a User ID,
QMF for Windows uses the last user ID specified for this server,
if available, or displays a dialog box if none is available. This
parameter is ignored if ServerName is NULL or an empty string.

Password If you specified a different server in ServerName, Password is the
password used for that server. If you do not specify a
password, QMF for Windows uses the last password specified
for this server, if available, or displays a dialog box if none is
available. This parameter is ignored if ServerName is NULL or
an empty string.

ForceDialog If you specified a different server in ServerName, nonzero forces
QMF for Windows to display a dialog box prompting for logon
information, even if a user ID and password were specified or
are otherwise available. Zero indicates that QMF for Windows
displays this dialog box only if necessary. This parameter is
ignored if ServerName is NULL or an empty string.

Account If you specified a different server in ServerName, optionally, a
string specifying accounting information to pass to that server
when connecting. The server may use this information in a job
accounting system. This parameter is ignored if ServerName is
NULL or an empty string.

Comment Optionally, a string that specifies a comment for the table in
which the data is saved.

CommitScope Optionally, how many rows to insert into the table at a time
before committing the unit of work. Specifying zero indicates
that all of the rows should be inserted before committing.
Specifying 10 (for example), indicates that a commit should be
performed after every ten rows are inserted.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information. If
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the result set is empty or no rows are retrieved from the database, nonzero is
returned unless FirstRow=0, and LastRow=-1. In this case, zero is returned
and an empty table is created.

SaveQMFProc()
short SaveQMFProc(BSTR OwnerAndName, BSTR Text, BSTR Comment, BOOL
Replace, BOOL Share)

Description
This function saves a procedure at a database server.

Parameters

Name Description

OwnerAndName A string containing the owner and name, separated by a period,
of the procedure that you want to save. For example,

John.Proc2

Text A string containing the text that you want to save in the
procedure.

Comment A string containing any comment that you want to save with
the procedure. If there is no comment, pass this parameter as
either an empty string or NULL.

Replace Nonzero replaces an existing procedure with the same name.
Zero aborts the operation if there is an existing procedure with
the same name.

Share Nonzero shares the procedure with other users. Zero does not
share the procedure with other users.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

SaveQMFQuery()
short SaveQMFQuery(BSTR OwnerAndName, BSTR Text, BSTR Comment, BOOL
Replace, BOOL Share)

Description
This function saves a query at a database server.

Parameters

Name Description
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OwnerAndName A string containing the owner and name, separated by a period,
of the query that you want to save. For example,

John.Query2

Text A string containing the text that you want to save in the query.

Comment A string containing any comment that you want to save with
the query. If there is no comment, pass this parameter as either
an empty string or NULL.

Replace Nonzero replaces an existing query with the same name. Zero
aborts the operation if there is an existing query with the same
name.

Share Nonzero shares the query with other users. Zero does not share
the query with other users.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

SetBindOption()
short SetBindOption(BSTR CollectionName, BSTR PackageName, short Option,
short Value)

Description
This function sets options for the collection and package prior to calling
EndBind().

Parameters

Name Description

CollectionName The collection ID of the package for which you want to set the
option.

PackageName The name of the package for which you want to set the option.

Option One of the options listed below.

Value Nonzero replaces an existing query with the same name. Zero
aborts the operation if there is an existing query with the same
name.

Share One of the values listed below for the specified option.

Meanings and values for the various options are as follows:

Option Meaning Description
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DDM_PKGRPLOPT(0x211C) Flag specifying whether or
not to replace an existing
package with the same
collection ID and name.

DDM_PKGRPLALW (0x241F)
Yes
DDM_PKGRPLNA (0x2420)
No

DDM_STTDECDEL(0x2121) The delimiter used for the
decimal point in SQL
statements in the package.

DDM_DECDELPRD (0x243C)
Period
DDM_DECDELCMA (0x243D)
Comma

DDM_STTSTRDEL(0x2120) The delimiter used for
string values in SQL
statements in the package.

DDM_STRDELAP (0x2426)
Apostrophe
DDM_STRDELDQ (0x2427)
Double Quote

DDM_PKGISOLVL(0x2124) The isolation level for the
package.

DDM_ISOLVLALL (0x2443)
All
DDM_ISOLVLCHG (0x2441)
Change
DDM_ISOLVLCS (0x2442)
Cursor Stability
DDM_ISOLVLNC (0x2445)
No Commit
DDM_ISOLVLRR (0x2444)
Repeatable Read

DDM_PKGATHOPT(0x211E) Flag specifying whether or
not to keep existing
authorizations on the
package.

DDM_PKGATHKP (0x2425)
Keep
DDM_PKGATHRVK (0x2424)
Revoke

DDM_QRYBLKCTL(0x2132) The method to use when
fetching rows of data for
queries in the package.

DDM_FIXROWPRC (0x2418)
Row at a time
DDM_LMTBLKPRC (0x2417)
Block at a time

DDM_RDBRLSOPT(0x2129) When to release database
resources acquired when
running the package.

DDM_RDBRLSCMM (0x2438)
Commit
DDM_RDBRLSCNV (0x2439)
Conversation Deallocation

DDM_STTDATFMT(0x2122) Format for retrieved date
values.

DDM_ISODATFMT (0x2429)
ISO
DDM_USADATFMT (0x242A)
US
DDM_EURDATFMT (0x242B)
European
DDM_JISDATFMT (0x242C)
Japanese Industrial Standard
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DDM_STTTIMFMT(0x2123) Format for retrieved time
values.

DDM_ISOTIMFMT (0x242E)
ISO
DDM_USATIMFMT (0x242F)
US
DDM_EURTIMFMT (0x2430)
European
DDM_JISTIMFMT (0x2431)
Japanese Industrial Standard

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

SetBindOwner()
short SetBindOwner(BSTR CollectionName, BSTR PackageName, BSTR OwnerID)

Description
This function enables you to specify an owner different from your user ID for
the package you are binding. This may be necessary if your user ID does not
have the required authorizations to bind the package, but the specified owner
does.

Parameters

Name Description

CollectionName The collection ID of the package for which you want to specify
the owner.

PackageName The name of the package for which you want to specify the
owner.

Comment A string containing any comment that you want to save with
the query. If there is no comment, pass this parameter as either
an empty string or NULL.

OwnerID The desired owner ID for the package you are binding.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.

SetBusyWindowButton()
void SetBusyWindowButton(BSTR Text)
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Description
This function specifies the text displayed on the busy window’s Cancel
button.

Parameters

Name Description

Text A string that specifies the text displayed on the busy window’s
Cancel button. The default value is ″Cancel″. If you specify an
empty string the button is hidden. Regardless of the text you
specify, the button always cancels, or closes, the window.

Return Value
None.

Related Topics
SetBusyWindowMessage()
SetBusyWindowMode()
SetBusyWindowTitle()
ShowBusyWindow()

SetBusyWindowMessage()
void SetBusyWindowMessage(BSTR Message)

Description
This function specifies the text displayed in the busy window’s message area.

Parameters

Name Description

Message A string that specifies the text displayed on the busy window’s
message area.

Return Value
None.

Related Topics
SetBusyWindowButton()
SetBusyWindowMode()
SetBusyWindowTitle()
ShowBusyWindow()

SetBusyWindowMode()
void SetBusyWindowMode(short Mode)
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Description
This function determines whether or not QMF for Windows displays the busy
window. The busy window is useful to provide feedback to the user and to
enable the user to cancel a pending database action. Your changes take effect
the next time QMF for Windows performs an operation that causes the busy
window to display or hide.

Parameters

Name Description

Mode Specifies when QMF for Windows displays the busy window:

Value Meaning

0 (RSM_NEVER) The window does not display. This is the default.

1 (RSM_WHENBUSY) The window displays when QMF for Windows is
busy communicating with the database. QMF for
Windows automatically displays this window as
appropriate.

2
(RSM_CLIENTCONTROLLED)

The window displays after you call
ShowBusyWindow(TRUE), and after you call
ShowBusyWindow(FALSE). The client determines
when the window displays.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

Related Topics
SetBusyWindowButton()
SetBusyWindowMessage()
SetBusyWindowTitle()
SetParent()
ShowBusyWindow()

SetBusyWindowTitle()
void SetBusyWindowTitle(BSTR Title)

Description
This function specifies the text displayed in the busy window’s title bar.

Parameters

Name Description
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Title A string that specifies the text displayed on the busy window’s
title bar.

Return Value
None.

Related Topics
SetBusyWindowButton()
SetBusyWindowMode()
SetBusyWindowMessage()
ShowBusyWindow()

SetGlobalVariable()
short SetGlobalVariable(BSTR Name, BSTR Value)

Description
This function assigns a value to the specified global variable. This value is
available for use in queries, forms, and procedures.

Parameters

Name Description

Name A string that contains the name of the variable you want to set.

Value A string that contains the value you want to assign to the
specified variable.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

SetHostVariable()
short SetHostVariable(long QueryID, VARIANT Index, VARIANT Value)

Description
This function assigns a value to the specified host variable referenced by the
query. The query must be a static query referencing host variables (either
stored with the QMF query or created by AddHostVariable()). Index can
specify either the numeric index of the host variable, or the name of the host
variable.

Parameters

Name Description

QueryID The ID of the query as returned from InitializeStaticQuery().
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Index Either a number (variant type VT_I2) specifying the index of the
host variable in the query, or a string (variant type VT_BSTR)
specifying the name of the host variable.

Value The value for the host variable. To specify a null value, the type
of the variant should be set to VT_EMPTY.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

SetOption()
short SetOption(short Mode, VARIANT Value)

Description
This function sets the specified option value in QMF for Windows. For some
options, the changes do not take effect until QMF for Windows restarts. Under
normal conditions, you do not restart QMF for Windows until you have
destroyed all instances of the QMF for Windows API object.

Parameters

Name Description

Option Specifies which option to set:

Value Meaning

0 (RSO_SERVER_DEFINITION_FILE) Server definition file name.

1 (RSO_CPIC_DLL) CPI-C Provider DLL file name.

2 (RSO_CPIC_TIMEOUT_WARNING) CPI-C warning timeout (in seconds). This
limit is not used for the QMF for Windows
API.

3 (RSO_CPIC_TIMEOUT_CANCEL) CPI-C cancel timeout (in seconds).

4 (RSO_TCP_TIMEOUT_WARNING) TCP warning timeout (in seconds). This limit
is not used for the QMF for Windows API.

5 (RSO_TCP_TIMEOUT_CANCEL) TCP cancel timeout (in seconds).

6 (RSO_DISPLAY_NULLS_STRING) The string used to display null values.

7 (RSO_ENTER_NULLS_STRING) The string used to enter null values.

8 (RSO_ENTER_DEFAULTS_STRING) The string used to enter default values.

9 (RSO_TRACE_FILE_1) Trace file 1 name.

10 (RSO_TRACE_FILE_2) Trace file 2 name.

11 (RSO_TCP_TRACE_LEVEL) TCP trace level.
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12 (RSO_CPIC_TRACE_LEVEL) CPI-C trace level.

13 (RSO_DDM_TRACE_LEVEL) DDM trace level.

Name Description

Value The value to which to set the option.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

Related Topics
GetOption()

SetParent()
short SetParent(long ParentWnd)

Description
This function sets the parent window for dialogs. Normally, when QMF for
Windows displays a dialog (in the busy window or the User Information
dialog box), it is centered on and modal to the QMF for Windows main
window. This function enables you to force the QMF for Windows dialog
boxes to be centered on and modal to your client application window.

Parameters

Name Description

ParentWnd The HWND of the new parent window. Specify NULL to use
the QMF for Windows main window as the parent.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

Related Topics
ShowBusyWindow()

SetProcVariable()
short SetProcVariable(long ProcID, BSTR Name, BSTR Value)
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Description
This function assigns a value to the specified variable. This value is
substituted for the variable prior to running the procedure. If your procedure
has one or more variables in it, you must call this function to set the variable
values prior to calling RunProc().

Parameters

Name Description

ProcID The ID of the procedure as returned from InitializeProc().

Name A string that contains the name of the variable that you want to
set.

Value A string that contains the value that you want to assign to the
specified variable.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.

SetVariable()
short SetVariable(long QueryID, BSTR Name, BSTR Value)

Description
This function assigns a value to the specified variable. This value is
substituted for the variable prior to running the SQL statement. If your SQL
statement has one or more variables in it, you must call this function to set
the variable values prior to calling either Open() or Execute().

Parameters

Name Description

QueryID The ID of the query as returned from InitializeQuery().

Name A string that contains the name of the variable that you want to
set.

Value A string that contains the value that you want to assign to the
specified variable.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType() to get additional error
information.
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ShowBusyWindow()
void ShowBusyWindow(BOOL Show)

Description
This function tells QMF for Windows to either show or hide the busy
window. The busy window is useful to provide feedback to the user and
enables the user to cancel a pending database action. This function only works
if you cal SetBusyWindowMode() with a mode of
RSM_CLIENTCONTROLLED. If you set a parent window by calling
SetParent(), the busy window is modal to the specified window.

Parameters

Name Description

Show Nonzero shows the busy window; zero hides the busy window.
If nonzero, the busy window displays until you call
ShowBusyWindow() with Show set to zero.

Return Value
None.

StartBind()
short StartBind(BSTR CollectionName, BSTR PackageName, BSTR
ConsistencyToken)

Description
This function begins the process of binding a package in the database.

Parameters

Name Description

CollectionName The desired collection ID for the package.

PackageName The desired name for the package.

ConsistencyToken A string 16 characters long containing the hexadecimal
representation of an eight-byte token used to ensure consistency
between the package bound in the database and an application
using that package. When a section is executed within the
package, you must provide this same value.

Return Value
Zero if successful, nonzero if unsuccessful. If the return value is nonzero, you
can call GetLastErrorString() or GetLastErrorType(), GetLastSQLCode(),
GetLastSQLError(), or GetLastSQLState() to get additional error information.
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Related Topics
EndBind()
CancelBind()
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Appendix. Notices

This information was developed for products and services offered in the
U.S.A. IBM may not offer the products, services, or features discussed in this
document in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10594-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any
other country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will

© Copyright IBM Corp. 1997, 2000 135



be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is as your own risk.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM Corporation
J74/G4
555 Bailey Avenue
P.O. Box 49023
San Jose, CA 95161-9023
U.S.A.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement, or any equivalent
agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments
may vary significantly. Some measurements may have been made on
development-level systems and there is no guarantee that these measurements
will be the same on generally available systems. Furthermore, some
measurement may have been estimated through extrapolation. Actual results
may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available
sources. IBM has not tested those products and cannot confirm the accuracy
of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change
or withdrawal without notice, and represent goals and objectives only.
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All IBM prices shown are IBM’s suggested retail prices, are current and are
subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is
subject to change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include
the names of individuals, companies, brands, and products. All of these
names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language,
which illustrates programming techniques on various operating platforms.
You may copy, modify, and distribute these sample programs in any form
without payment to IBM, for the purposes of developing, using, marketing or
distributing application programs conforming to the application programming
interface for the operating platform for which the sample programs are
written. These examples have not been thoroughly tested under all conditions.
IBM, therefore, cannot guarantee or imply reliability, serviceability, or function
of these programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Appendix. Notices 137



Trademarks

The following terms are trademarks of the IBM Corporation in the United
States or other countries or both:

ACF/VTAM
Advanced Peer-to-Peer

Networking
AIX
AIX/6000
AS/400
C/370
CICS
CICS/ESA
CICS/MVS
CICS/VSE
COBOL/370
DATABASE 2
DataJoiner
DB2
DB2 Universal Database
Distributed Relational

Database Architecture
DRDA
DXT
GDDM
IBM

IBMLink
IMS
Language Environment
MVS
MVS/ESA
MVS/XA
OfficeVision/VM
OS/2
OS/390
PL/I
PROFS
QMF
RACF
S/390
SQL/DS
Virtual Machine/Enterprise

Systems Architecture
Visual Basic
VM/XA
VM/ESA
VSE/ESA
VTAM

Java or all Java-based trademarks and logos, and Solaris are trademarks of
Sun Microsystems, Inc. in the United States, other counrtries, or both.

Lotus and 1-2-3 are trademarks of Lotus Development Corporation in the
Unites States, other counrties, or both.

Microsoft, Windows, and Windows NT are trademarks or registered
trademarks of Microsoft Corporation.

Other company, product, and service names, which may be denoted by a
double asterisk (**), may be trademarks or service marks of others.
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